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Online Resources

» These slides
http://sci2.cns.iu.edu/docs/2011-borner-SciTS-workshop.pdf
» Sci2 Tool Manual v0.5 Alpha
http://sci2.wiki.cns.iu.edu
> Sci2 Tool v0.5 Alpha (April 4, 2011)
http://sci2.cns.iu.edu

» Additional Datasets
http://sci2.wiki.cns.iu.edu/2.5+Sample+Datasets
» Additional Plugins
http://sci2.wiki.cns.iu.edu/3.2+ Additional+Plugins

Or copy them from the DVD or memory stick.
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Q Workshop Overview

1:15 Marcoscope Design and Usage & CIShell Powered Tools: NWB &
Sci2

1:45 Sci2 Tool Basics

» Download and run the tool.

2:00 Sci2 Sample Workflow: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

2:30 Sci2 Sample Workflow: Studying Four Major NetSci Researchers.

» Load and clean a dataset as text file; process raw data into networks.
»  Find basic statistics and run various algorithms over the network.

» Visualize as either a circular hierarchy or network

3:30 Break

4:00 Sci2 Demo I: Geospatial maps with congressional districts

4:30 Sci2 Demo II: Evolving collaboration networks

4:45 Outlook and Discussion

5:00 Adjourn
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Different datasets/formats.
Diverse algorithms/tools written in

many programming languages.

Physics



@) The Changing Scientific Landscape

Star Scientist -> Research Teams: In former times, science was driven by key scientists.
Today, science 1s driven by effectively collaborating co-author teams often comprising
expertise from multiple disciplines and several geospatial locations (Bérner, Dall'Asta,

Ke, & Vespignani, 20
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Cyberinfrastructure and Datasets
for SciTS Research

Wednesday, April 13 ¢ 12:00 PM - 1:15 PM
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study one specimen at a time. Today, many researchers must make sense of massive
streams of multiple types of data with different formats, dynamics, and origin.

Static Instrument -> Evolving Cyberinfrastructure (CI): The importance of hardware
instruments that are rather static and expensive decreases relative to software

infrastructures that are highly flexible and continuously evolving according to the

needs of different sciences. Some of the most successful services and tools are
decentralized increasing scalability and fault tolerance.



Macroscope Design

Custom Tools for Different Scientific Communities
Information Visualization Cyberinfrastructure
http://iv.cns.iu.edu
Network Workbench Tool + Community Wiki
http://nwb.cns.iu.edu

Science of Science (Sci?) Tool and Portal

http://sci2.cns.ju.edu

Epidemics Cyberinfrastructure

Coming soon

180+ Algorithm Plugins and Branded GUIs
+

Core Architecture

Open Services Gateway Initiative (OSGi) Framework.
http://otgi.org
Cyberinfrastructure Shell (CIShell)
http://cishell.org

— osei RGNS
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CIShell Powered Tools:
Network Workbench (NWB)



Network Workbench TOOI Downloads for NWB Tool Releases

http://nwb.slis.indiana.edu

A Workbench for Network Scientists

89,559

40,000

The Network Workbench (NWB) tool
supports researchers, educators, and
practitioners interested in the study of

30,000

A Workbench for Network Sci

biomedical, social and behavioral science, T
m People Research Publications :

Cumulative Total of Downloads [

physics, and other networks.
In February 2009, the tool provides more 169 | summary _
Netwark Workbench: A Large-Scale Networl 1o co
; ; Toalkit for Biomedical, Social Science and A
Pluglns that Support the preprOC6581ng> evaluate, and operate a unigue distributed,
lvsi li . li . f scale network analysis, modeling, and visuz)
analysis, mode ng, and visualization o (NWBE). The ervisioned data-code-cormputin
more
networks. How to cite this project o
Diec-oi Dec-a7 Dlec-o8 Dec-og  Aug-1o
1 News 8 Updates
More than 50 of these plugins can be eeter W03 B 07 post
b4 b4 b4 = o aelnle, omeve. CMEPRIng e
applled or were speCIfically deSlgned for Knowledte. Research & Creativ ACtviY, 3 v.0.4 B 08+ pre
. fwehsite accessed AM1/09)
S&T studies. 3.73.09 1.0.0 beta 5 Released = o = e
. LAl iN Ela ElBASE
v.0.6 v.1.0.0 + pre
= 1.22.09 Ann Meranie's tutorial abstract for 5
2008 Total # of Downloads
It has been downloaded motre than 65,000 + 11.4.08 Two NWB Pis featured in "Connected—The  efting Started
. . Power of Six Degrees.” 2008, Anna Maria Talas, See more documentation
Director. Australian Broadcasting Corporation, Ltd. B
times since December 2006. T

Herr 11, Bruce W., Huang, Weixia (Bonnie), Penumarthy, Shashikant & Birner, Katy. (2007). Designing Highly Flexible and Usable
Cyberinfrastructures for Convergence. In Bainbridge, William S. & Roco, Mibail C. (EEds.), Progress in Convergence - Technologies for Human

Wellbeing (Vol. 1093, pp. 161-179), Annals of the New York Academy of Sciences, Boston, MA.
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http://nwb.slis.indiana.edu/

A Workbench for Network Scientists

Investigators:

Software Team:

Goal:

Amount:
Duration:

Website:

Katy Borner, Albert-Laszlo Barabasi, Santiago Schnell,
Alessandro Vespignani & Stanley Wasserman, Eric Wernert

Lead: Micah Linnemeier |
Members: Patrick Phillips, Russell Duhon, Tim Kelley & Ann McCranie
Previous Developers: Weixia (Bonnie) Huang, Bruce Herr, Heng Zhang,

Duygu Balcan, Bryan Hook, Ben Markines, Santo Fortunato, Felix
erkhom Ramya Sabbmem Vivek S. Thakre & Cesar Hldalgo

Develop a large-scale network analysis, modeling and visualization toolklt
for physics, biomedical, and social science research.

$1,120,926, NSF T1S-0513650 award
Sept. 2005 - Aug. 2009

http://nwb.slis.indiana.edu
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Project Details (cont.)

NWB Advisory Board:
James Hendler (Semantic Web) http://www.cs.umd.edu/~hendler/
Jason Leigh (CI) http://www.evl.uic.edu/spiff/

Neo Martinez (Biology) http://online.sfsu.edu/~webhead/
Michael Macy, Cornell University (Sociology)

http://www.soc.cornell.edu/faculty/macy.shtml
Ulrik Brandes (Graph Theory) http://www.inf.uni-konstanz.de/~brandes/

Mark Gerstein, Yale University (Bioinformatics) http://bioinfo.mbb.yale.edu/
Stephen North (AT&T) http://public.research.att.com/viewPage.cfm?PagelD=81

Tom Snijders, University of Groningen http://stat.gamma.rug.nl/snijders/

Noshir Contractor, Northwestern University http://www.spcomm.uiuc.edu/nosh/
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Computational Proteomics

What relationships exist between protein targets of all drugs and all
disease-gene products in the human protein—protein interaction network?

Yildriinm, Mubammed
A., Kwan-1I Gob,
Michael E. Cusick,
Albert-1 dszlo Barabast,

and Marc Vidal. (2007).

Drug-target Network.
Nature Biotechnology
25 no. 10: 1119-1126.

@ © 2007 Nature Publishing Group
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Figure 2 Drug—target network (DT network). The DT network is generated by using the known associations between FDA-approved drugs and their target
proteins. Circles and rectangles correspond to drugs and target proteins, respectively. A link is placed between a drug node and a target node if the protein

i= a known target of that drug. The area of the drug (protein) node is proportional to the number of targets that the drug has (the number of drugs targeting
the protein). Color codes are given in the legend. Drug nodes (circles) are colored according to their Anatomical Therapeutic Chemical Classification, and the
target proteins (rectangular boxes) are colored according to their cellular component obtained from the Gene Ontology database.
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Computational Economics

vegetable oils

Does the type of product that a fishing
country exports matter for o l* 1 b e %
. | L ., .
subsequent economic performance? A @ [ Q\\[&) ./ 2/ ¢ torestand paper
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. N \ [T -
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products - i o T LA »
C. A. Hidalgo, B. Klinger, e A 'Y mining

A.-L. Barabasi, R. Hausmann
(2007) The Product Space oe s :
Conditions the Development s g 0N < - 'V.. = P
of Nations. Science 317, i s N
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Fig. 1. The product space. (A} Hierarchically clustered proximity (4) matrix
representing the 775 SIMC-4 product classes exported in the 1998—2000
period. (B) Network representation of the product space. Links are color coded  Leamer.

with their proximity value. The sizes of the nodes are proportional to world
trade, and their colors are chosen according to the classification introduced by
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Second sight
Computational Social Science

Imana; Bruce W, Hest and Tadd M. Holloway

Studying large scale social
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Second Sight: An Emergent Mosaic of
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Computational Epidemics

Forecasting (and preventing the effects of) the next pandemic.

Epidemic Modeling in Complex realities, V. Colizza, A. Barrat, M. Barthelemy, A.1 espignani, Comptes Rendus

Biologie, 330, 364-374 (2007).

Reaction-diffusion processes and metapopulation models in heterogeneous networks, 1.Colizza, R. Pastor-Satorras,
A.Vespignani, Nature Physics 3, 276-282 (2007).

Modeling the Worldwide Spread

of Pandemic Influenza: Baseline

Case and Containment Interventions,

V. Colizza, A. Barrat, M. Barthelem,
A.-J. Valleron, A.V espignan;,
PloS-Medicine 4, 13, 95-110 (2007).
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NWB Tool Download, Install, and Run

NWB Tool 1 O 0 (= Network Workbench | Download - Windows Internet Explorer

@.\—_/-.' |§, hikbpeffnwb, slis.indiana,eduf download, el V| @ ‘? X~ |'-'ln|hbulld\n931 campus map ‘ Bedks
Can be freely downloaded for all i:Favor‘ltes ‘r:;_‘;, ;D;Iu::este::tes 'epg, Free Hotmail & | Web Slice Gallery ~
1 1 52|~ & gigapan: no intro /& Metwork Waorkbench | D... % ﬁ i = | @ - Page - Safety ~ Tools - @- i
major operating systems from = - L -
http:/ /nwb.cns.iu.edu
[ : WOl KVVQO
SeleCt your Operatlng syStem from A Workbench for Netwark Scientists [:LOGIN:I
the pull down menu and download. Home People Research Publicafions Community Documentation Dev Zone About
Unpack into a /nwb directory. o
Ru n / Ile / ﬂWb. exe - Du\:‘:]iads for NWB Tool F:ch-:et N
;uoll 1.l:).l:l ?gl;i;izlﬂgglease 1
eptember 15th,
Release Notes seee
Session log files are stored in
¢ ; ) . 5000
*yournwbdirectory*/ logs’ directory. { w N
Baot Linox -
Intel Mac OSX
G3/G4/G5 Mac OSX =
Cite as NWB-Demo :;, o
gEtn‘:DSth. 2008 'g 10,000
NWB Tedm. (2006)- Nejwor/é Release Notes E
Workbench Tool. Indiana University, { w T
Northeastern University, and University of JEONZ e N
Michigan, bitp:/ [ nwb.cns.in.edu. ‘ s o
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A Workbench for Network Scientists

% Network Workbench Tool

File Preprocessing Modeling  Analysis  Visualizakion  Scientometrics  Help

El console

1il Data Manager =0
[ ]

:SQVE; ||:*I]'d_| \l'iE'WJ ETI:_:I ﬂnd ...........................................................

. . =
Console displays dato operations
repracessing, madeling, analysis, and -

[\Welcome to the Mebw ' -
{wisualization of small, algorithm input parameters,
selection, & acknowledgements as
The Metwork, Workbend  well as error reporting. = supported in part by the MSF

I15-051 3650 award, Theprmarrrmresogamorsare ooy oo, Dr, Albert-Laszld Barabasi, Dr, Santiago
Schnell, Dr. Alessandro Vespignani, Dr. Stanley Wasserman, and Dr. Eric A, Wernert,

The MWE kool was developed by Weixia Huang, Russell Duhon, Micah Linnemeier, Timothy Kelley, Duyvgu
Balcan, Mariano Beird, Bruce Herr, Santo Forkunato, Ben Markines, Felix Terkharn, Heng Zhana, Meaha
Ramawat, César Hidaloo, Rarmya Sabbineni, Wivek Thalkres, Soma Sanyal, Ann MoCranie, Alessandro
Wespignani, and Kaky Barner. It uses the Cvberinfrastructure Shell (hitp:/ fcishell.org) developed at the
Cywberinfrastructure For Metwark Science Center (hitpe/ /ons.slis.indiana.edu) at Indiana University,

Please cite as follows:

[MWE Team. (Z006), Mebwoark Warkbench Tool. Indiana University and Maortheastern University, —
ihtl:p :/ inwb.slis. |nd|ana edu

| %

Scheduler lists what algorithms you've
& scheduler used and displays algorithm

rogress.
Remove From Lisk P |

| I algorithrm Mame Date Time %= Complete

Data Manager keeps track of
all datasets that are available
for algorithmic visvalization
or manipulation.

Table
Matrix:

B Plot

B Text
G GuEss

9 Tree

i * Network-

Console shows references to seminal works.

Workflows are recorded into a log file, and soon can be re-run for easy replication.

All algorithms are documented online; workflows are given in tutorials.
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A Warkbench for Network Scientists

File, Preprocessing, Modeling, and Visualization Menus

[File |

Preprocessing

Maodeling

Load. ..

Load and Clean ISI File
Read Directory Hierarchy
Dakasets

Exctrack Top Modes

Extract Modes Abowve or Below Yalue
Remove Mode Attributes

Delete High Degres Modes

Save...

Delete Random Modes
Delete Isolates

View, .,
Wigw with. ..

YWisualization

Randaom Graph
Wi'atks-Strogatz Small Wiorld
Barabasi-albert Scale-Free

GLUESS

ERURok

Can
Zhord

Extract Top Edges
Extrack Edges Above or Below Yalue

Merge Mode and Edge Files
Split Graph to Mode and Edge Files

Remove Edge Attributes
Remove Self Loops

Tesks

Trim by Degree

Hyperagrid
PRLU

DrL (xOrd)
Specified {prefuse beta)

Circular {JUMG)

Radial Tree/Graph (prefuse alpha)

TARL

Radial Tree/Graph with Annokation {prefuse beta)

Miscrete Metwark Dynanmics (DHNED

Tree Map (prefuse beta)

Evolving Metwork (Meighted)

Preferences

snowball Sampling (0 nodes)
Mode Sampling

Exit

Edge Sampling

Tree Yiew (prefuse beta)
Ballaom Graph (prefuse alpha)

Borner, Katy, Sanyal, Soma and Vespignani, Alessandro (2007). Network Science. In Blaise Cronin (Ed.),
ARIST, Information Today, Inc./ American Society for Information Science and Technology, Medford, NJ,

Symmekrize
Dichotomize
Mulkipartite Joining
rarmalize Text
Slice Table by Time

Volume 41, Chapter 12, pp. 537-607.
http://ivlslis.indiana.edu/km/pub/2007-borner-arist.pdf

Force Directed with Annotation (prefuse beta)
kKamada-kawai (MG

Fruchterman-Reingold {JUME)

Fruchterman-Feingold with Annotation (prefuse beta)
Spring (IUMGE)

Small World {prefuse alpha)

Parallel Coardinates (dema)

Lalet

Circular Hierarchey
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Analysis Menu and Submenus

A Workbench for Netwark Scientists

Analysis Unweighted and Undirected » | Urwweighted and Directed » |

Metwork Analysis Toolkit (NAT) e De'?!'e'? ‘ :D:E lcl;'d;gree
Unweighted and Undirected Peziceiiaiion : ° p =P ;TT .

: ; ndegree Distribution
Weighted and Undirected YWatts-Strogatz Clustering Coefficient o

. : Outdegree Distribution
Unweighted and Directed ‘Watts Strogatz Clustering CoefFicient over K
Weighted and Directed k-Mearest Meighbor
Diameter . .
Single Node In-Out Deqgree Correlations

Search Average Shorkest Path
Discrete MNetwork Dynamics Shortest Path Distribution PageRank
Textual Mode Betweenness Centrality HITS

Global Connected Components

Dwvad Reciprocity

\Weighted and Undirected b I HITS Arc Reciprocity

, - Adjacency Transitivity
Clustering Coefficient Weak Component Clustering
Mearest Meighbor Degree Blondel Community Detection Weak Component Clustering
Strength vs Degree Strong Component Clustering

Degree & Strength MST-Pathfinder Metwork Scaling

Average Weight vs End-point Deagree
k-Mearest Neighbor (1ava)

Blondel Community Detection
Extrack K-Core

Annotate K-Coreness Extrack K-Core
Strength Distribution Annotate K-Coreness
YWeight Distribution Weighted and Directed » I_
Randomize Weights HITS Search P TR y
MST-Pathfinder Metwork Scaling il e R T LS Can Burst DEtEckion |
Fast Pathfinder Metwork Scaling Fast Pathfinder Metwork Scaling Chord

K Random-Wall Discreke Metwork Dynamics »

Blondel Community Detection Elondel Community Detection Random Breadth First Extract and &nnotate Atbractors

Borner, Katy, Sanyal, Soma and Vespignani, Alessandro (2007). Network Science. In Blaise Cronin (Ed.),
ARIST, Information Today, Inc./ American Society for Information Science and Technology, Medford, NJ,
Volume 41, Chapter 12, pp. 537-607. http://ivLslis.indiana.edu/km/pub/2007-borner-arist.pdf
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CIShell — Customize Menu

» The file Yourtooldirectory/ configuration/ defanlt_menn.>xm!’ encodes the structure of

the menu system.
» In NWB Tool, the Modeling menu (left) is encoded by the following piece of

xml code:

El consale

INE METWOrK Workne
investigators are Dr. k
Wyasserrnan, and Dr. B

The NwWE tool was dg
Tank, Joseph Bibersti
Terkhorn,Heng Zhan
Wespignani, and Katy

Metiark Warkbench
Science Center (hitp:

Please cite a3 follows
MNWE Tearn. (20063, I
http:finwb.slis.indial

'@ MNetwark Workbench Tool

File Preprocessing | Modeling | Analysis  Visualization  Scientometrics

Randam Graph
Wifatts-Strogatz Small World
Barabési-Albert Scale-Free

Can
Chord
Hypergrid
PRU

TARL
Discrete Metwaork Dynarmics (D

Evolving Metwork (dfeighted)

Ea

Sch

1;
fuce
nen

b d
<top_menu name="madaTing" >
<menu pid="edu.iu.nwh.modeling. erdosrandomgraph” /=
<menu pid="edu.ju.nwh.modeling. smallworTd" />
<menu pid="edu.iu.nwh.modeling.barabasialbert" >
<menu type="break"/>
<menu pid="edu.ju.iv.modeling. p2p. can. CanAlgorithm" />
<menu pid="edu.iu.iv.modeling. p2p.chord.Chardalgorithm” />
<menu pid="edu.id.iv.modeling. p2p. hypergrid. Hypergrid" >
<menu pid="edu.fu.iv.modeling. p2p. pru. Prudlgorithm” />
<Hent type=“break“ﬁ>
<menu pid="edu.du.iv.modeling. tarl.TarTalgorithm" /=
<Henu type=“break“f>
<menu pid="edu.iu.mwh.modeTing. discretenetworkdynamics. DuDATgorithm" /=
<menu type="hreak"/>
<menu pid="edu.iu.mwh.modeTing. weighted. evolvingnetwork" /=

</Top_menus




YRABVVO

A Workbench for Netwark Scientists

Integrated Tools

I8 gnuplot graph

=100

0.5

. il
's5ion-5589 WStaticExecutableRunner-55897WALGORITHMdegree_distribution. dat vt

045 T

047

192132, % 52011 100 150 200

[am)
{Jﬂw T F

280

% - ¥isualization - GUESS =] 3]
Eile  Edit Layout Script wiew  Help
Medici

é Field | Walue
é color cornflowierblue
< [fized False
& [height 100
gimage
E |label Medici
~ labelcolor 255,0,0,255
labelsize 1z
labelisible False
name n3
priorates 53
strokecolor cadetblue
skyle 2
kotalkies 54
isible true
wealh 103
wicleh 10.0
b 90933242797, .,
W 35.199966430. .,
obets [ ] propent: cpertari [2==] vaue
olour || show || hide |[ Sze || showlshel || HdeLabel || changeLabel
| modeshape || center || changetistory |
Inkerpreter | Graph Modfier |

Gnuplot

portable command-line driven
interactive data and function plotting
utility http://www.gnuplot.info/.

GUESS

exploratory data analysis and visualization tool
for graphs and networks.

https://nwb.slis.indiana.edu/community/?n=Vi
sualizeData. GUESS.
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Supported Data Formats

A Workbench for Network Scientists

The NWB tool supports loading the following input file formats:
GraphML (*.xml or *.graphml)

XGMML (*.xml)

Pajek NET (*.net) & Pajek .Matrix (*.mat)

:
NWB (*nwb> . . . file text/nsf
edu.berkeley.guir.prefuse.graph.Graph
TreCML (*.Xml) . edu.berkeley.guir.prefuse.graph.TrJ \
Edge list (*.edge) o

filestextAegrmml+xml . flestext/isi

VYVYVVVVVVYVYVYVYVY

eduuciicsjung.graph.Graph . e data Tabl
CSV (*.CSV) ® :e.data.Treef / edeTe
L . . filetext/bibtex
ISI <*.151) etext/tree mlxml . prefuse.data.Graph
Scopus (*.scopus) ®
NSF <*nSf> . filetent fosw rleeerebh
. . . filetext/graphml+xml
Bibtex (*.bib)
Endnote (*.enw) Q..
and the following network file output formats: .WW‘ /
»  GraphML (*.xml or *.graphml) f plersisdae ® . ovtimage Butfredtmage
> Paiek MAT <*mat> . file:application/pajeknet \
» Pajek NET (*.net) ®...
iletext/jpg
> NWB (*nWb> . file:application/pajekmat
»  XGMML (*.xml)
» CSV (*.csv)

Formats are documented at https://nwb.slis.indiana.edu/community/?n=DataFormats.HomePage.

. filetext/scopus


https://nwb.slis.indiana.edu/community/?n=DataFormats.HomePage

CIShell Powered Tools:

Science of Science (Sci2) Tool



Science of Science (Sci2) Tool
http://sci2.cns.iu.edu

I;ggi?{t_:h & practice

» Explicitly designed for SoS research and practice, well documented, easy to use.

» Empowers many to run common studies while making it easy for exports to
perform novel research.

A\

Advanced algorithms, effective visualizations, and many (standard) workflows.

A\

Supports micro-level documentation and replication of studies.

A\

Is open source—anybody can review and extend the code, or use it for

commercial purposes.
SUMMARY

e Existing metrics have known flaws
e A reliable, open, joined-up data
infrastructure is needed
e Data should be collected on the full
O P | N | O N range of scientists’ work
® Social scientists and economists

should be involved

nature Vol 464|25 March 2010

Let’'s make science metrics more scientific

To capture the essence of good science, stakeholders must combine forces to create an open, sound and
consistent system for measuring all the activities that make up academic productivity, says Julia Lane.
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= Sci2'Tool - “Open Code for S&T Assessment”

D ' arch & practice

Joint Co-Authorship Network

OSGi/CIShell powered tool with NWB plugins and -

many new scientometrics and visualizations plugins.

Health Professionals |

©:-g° &
08— : &
= Yo, ) < s :
: — b = © : E
g : o ‘;’ & \1‘1 : (g) : A f
@@o@ S \ [/
5 ; i \ i
E Electrical Eng i = Brain Research ! E | \', " /
g puter Scien: \ 5 o wmustm : E e R AW Node Size & Color Edge Size & Color
- . = S Y Number of Pape: Number of Times
5, ‘90 \ Co-Authored
7 @ : = S
Biol 127
mro nlogy Eugene Garfield =
Earth Sciences 35 7
& 1
| |
Copyright (c} 2008 The Regents of the Liniversity of Cabrnta 1 127 1 33

O 9 Biology
O 9 Biotechnology

O 13 Brain Rescarch SCi Maps GUESS NetWOfk ViS

19 Chemical, Mechanical, & Civil Engineering

SCL Cybed. for Science & E:
. . SCI: ETF Early Operations - Indiana University n—
Horizontal Time Graphs e ety e s
Estensible Terascale Facility (ETE): Indiana-Pusdue Geid (IP-geid) ([
MRI. Creation of the AVIDD Data Facility: A Distributed Facility for Managing, Analyzing and Visualizing Instooment-Deiven Data [
DILI-2: Creating the Digital Msic Libeary

Network Connection for Reseacch and Education at Indiana Univessity and Indiana University-Pusdue University Indianapol
1996 1997 1998 1999 2000 2001 2002 2003 2004 2005 2006 2007 2008 2009 2010

Bérner, Katy, Huang, Weixia (Bonnze), Linnemeier, Micah, Dubon, Russell Jackson, Phillips, Patrick, Ma, Nianli, Zoss,
Angela, Guo, Hanning & Price, Mark. (2009). Rete-Netzmwerk-Red: Analyzing and 1 isualizing Scholarly Networks
Using the Scholarly Database and the Network Workbench Tool. Proceedings of ISST 2009: 12th International Conference
on Scientometrics and Informetrics, Rio de Janeiro, Brazil, July 14-17 . Va/. 2, pp. 619-630.
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Sci? Tool

v Sci Tool

File Preprocessing Modeling  Analysis | Visualization | Scientometrics  Help

El Console GUESS

Wifelcome to the Science of Science Tool (e GruPlot .

The developrment of this toal is supported in i Ge() Ma S

Metwork Science center and the School of Li Radial Tree/Graph (prefuse alpha) sp e adl
Indiana University, the Mational Science Fou Radial Tree/Graph with Annotation (prefuse beta) . o ol —

and II5-07153303, and the Jarmes 5 dcDonnel Tree Vi fuse b e -
Cyberinfrastructure portal (http:dfscislis.ind 2 Wy (gliEfiee Sei) =S
Tree Map (prefuse beta)

The prirmary irnestigators are Kabty Bérner, In
SciTech Strategies Inc, The Sci tool was dev

Force Directed with &nnotation {prefuse beta) — H

1. Duhar, Patrick A, Phillips, Chintan Tank, a Fruchterman-Reingold with Snnotation (prefuse beta)
Cybetinfrastructure Shell (httpeffcishell.org e
for Metwork Science Center (http:ffons.slis.iy Dirl M Oredd e ==
Marry algorithrm plugins were derived from 4 Specified fuse b " 8
thttp:ffnwhb.slis.indiana.edul. pecified (prefuse beta) :

Haorizontal Line Graph

Flease cite as follows:
Scif Tearn. (2009, Science of Science Toal, Ir Circular Hierarchy i
Strateqgies Inc., httpeffscislis.indiana.edu.
.......... Geo Map (circle annotations) Il

Bl Scheduler Geo Map (region colaring annotations) |

IF{emwe Fram List] ] Rernowe carnpleted Leige ity

Reffdapper

I algorithrm Marme Date Tirne % Con

| Extract Co-futhor Metw., 0970372009 00:15:20 A ———
[ Load and Clean ISIFile no9,o32009 00:15:05 A8 —
|

Circular Hierarchy

1| 1]

4 UL 2 ||




O 2 Workshop Overview

1:15 Marcoscope Design and Usage & CIShell Powered Tools: NWB & Sci2
1:45 Sci2 Tool Basics
» Download and run the tool.

2:00 Sci2 Sample Workflow: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

2:30 Sci2 Sample Workflow: Studying Four Major NetSci Researchers.

» Load and clean a dataset as text file; process raw data into networks.
»  Find basic statistics and run various algorithms over the network.

> Visualize as either a circular hierarchy or network

3:30 Break

4:00 Sci2 Demo I: Geospatial maps with congressional districts

4:30 Sci2 Demo 1I: Evolving collaboration networks

4:45 Outlook and Discussion

5:00 Adjourn
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nce of Science

s i Sci? Tool: Download, Install, and Run

R

Sci2 Tool v0.5 Alpha (April 4, 2011)

Can be freely downloaded for all major
operating systems from

http://sci2.cns.iu.edu

ep atio slcome do ore U
%ﬂ - |g http:/isci.slis.indiana.edufregistrationfuser] "“E‘ |E| ‘El |?' nih building 31 campus map ||E|

File Edit View Favortes Tools Help

o Favortes | o @ Suagested Stes + &) Fres Hotmal ] Web Sice Galery

ﬁ - B = @ -~ Page ~ Safety - Tools - @v =

A tool for science of science research & practice

Select your operating system from the 4 s

Password

pull down menu and download.

Unpack into a /sci2 directory. SO

To recover your account password, please visit our password r

Run /sci2/sci2.exe ——

Register now

Tutorials

: : Scott Weingart, Hanning Guo, Katy Bomer, Kevin W. Boyack, Micah W. Linnemeier, Russell . Duhon, Patrick A Phillips, Chintan Tank, and Jeseph
Cl a I l ua 1 s at Biberstine (2010) Science of Seience (Sei?) Tool User Manual. Cyberinfrastructure for Network Science Center, School of Library and Information

Science, Indiana University, Bloomington.
M 2 M M M d Katy Bomner and Angela Zoss (2010) PL nd-Play Macroscopes Tutorial. ional C on Social Computing, Behavioral Modeling and

° Prediction, Bethesda, MD.
http:/ /sci2.wiki.cns.iu.edu on Bt
E =

In the news

The Trustees of Indiana University. SLIS researcher promotes Innovation Dashboard for policymakers during Capitol Hill visit. (website accessed
12122/09).

Please cite as

)
Clte aS Sef Team. (2009). Science of Science (Sei') Tool. Indiana University and Scilech Strategies, hitp-/sci.slisindiana edu.

Acknowledgements

Sci Team. (2009). Science of Science (Sci?) Tool. [ ezt et e ittt i

University, the National Science Foundation under Grant No. SBE-0738111 and II5-0513630, and the James S. McDonnell Foundation.

Indiana University and Scilech Strategies, P nowa ey @) (g [
http:/ [ sci2.cns.iu.edn
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Sci? Tool: Download, Install, and Run

Sci2 Tool v0.5 Alpha (April 4, 2011)

Merging of networks

VYV VYV VY

Customizable stop word lists

New home page, wiki-based tutorial
Bug fixes, streamlined workflows

Supports ASCII UTF-8 characters
Web-based Yahoo! and desktop Geocoders
U.S. and World geomapper

| g S A S

Sci2 Tool runs on Windows, Mac, and Linux.

Unzip.
Run /sci2/sci2.exe

1 5¢i2-N-1.0.0.201008130505NGT-macosx.carbon.ppc.zip

; s¢i2=-N-1.0.0.201008130505NGT-macosx.carbonx8b.zip

) 5€i2-N-1.0.0.201008130505NGT-macosx.cocoaxBb_64.zip
 $€i2-N-1.0.0.201008130505NGT-win32.win32.x86.zip

1 sciz-N-1,
) aCid

UIJ':II
Browwse with Carel Paint Shop Pro Photo X2

Open Comrmand Prompt Here
Extract &ll...

Scan for Wiruses..,
T-Zip
Open YWith,.,

1 Magicls0

01,374 KB

Dpen archive
Extract files...
Extract Here

29



Sci2 Tool Interface Components
See also bttp:/ [ sci2.wiki.cns.in.edn/ 2.2+ User+Interface

research & practice

U W% Sci2 Tool [E=R(EcR(F<>)

SC File Data Preparation Preprocessing  Analysis  Modeling  Visualization  Help

> = Consolel = B || Data Manager = B8
Menu tO read data’) run Yelcome to the Science of Science Tool (Scif. "g Directary Tree - Prefi

. The development of this tool is supported in part by the Cyberinfrastructure for

algorlthms. Metwark Science center and the School of Library and Information Science at Indiana
Uniwversity, the Mational Science Foundation under Grant Mo, SBE-0738111 and

M5-0715303, and the James S, McDonnell Foundation, See Science of Science

e

Cyberinfrastructure portal thittp:ffscislisindiana.edu) for more information.
» Console to see work log, y poral i
. Prirmary investigators are Katy Bérner, Indiana University and Kewin W, Boyack, SciTech
references to Semlnal Works. Strategies Inc, The Sci® toal was developed by Micah W, Linnemeier, Russell J, Duhan,
Patrick &. Phillips, Chintan Tank, andJoseph B|herstme It uses the Cybermfrastructure A
o SN LIy BN Y PO N | N e VAT PN N S SN i SRR rebiiwn Few Blehnimele Tl
» Data Manager to select, view, | @ s =0

save 1oaded) Simlﬂated, or [ Rernove completed autamatically | Remowe all completed

derived datasets.

! Algorithm Mame Date Tirne %% Compl
> SCheduler tO see Status Of | Read Directory Hierarchy — 08/15/2010 IT0Z1TPYM s
. . i | i} | 3 S
algorithm execution. S ;

All workflows are recorded into a log file (see /sci2/logs/...), and soon can be re-
run for easy replication. If errors occur, they are saved in a error log to ease bug
reporting.

All algorithms are documented online; workflows are given in tutorials, see Sci2
Manual at http://sci2.wiki.cns.iu.edu
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Sci2 Tool — Read+Visualize Sci2 Tool Directory Tree

Use File > Read Directory Hierarchy’ with parameters

Il Read Directory Hierarchy |
Root direckory | CiDocuments and SettingsikatyDeskiop)mab ».'.’-:.-*
Levels ko recurse | 1 ».'.’-:.-*
¥ Recurse the entire tree Jr-f
[~ Read directories only (skips Files) x,‘_’."r.e

k. Cancel |

Visualize resulting ‘Directory Tree - Prefuse (Beta) Graph’ using
o Visualization > Tree View (prefuse beta)’

o Visualization > Tree Map (prefuse beta)’

o Visualization > Balloon Graph (prefuse alpha)’

»  Visualization > Radjal Tree/ Graph (prefuse alpha)’
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=laix
ree Vecwi (e PR e BalloonTree =10 x|

YeastMINT rwb
DrD

convertGraph_v0.8.0.graphml . :
Different views of the
fendster qraphml xm
friendster.xgmml.aml
humanprat b b d
kidscontest met

network: netsci0b-conferance.nat n W lreCtory
PSYCHCONSULT .nwb
seiyugraphml.aml

ot hierarchy.

wikipedia-20080103-science ennwb

bibtex bibsanamy bib
EpiC_20080614_BibTeX bib

csv barabasi.csv

endnote barabasi.enw
beetlehorn.isi

FourletSciResearchers.isi .

savedrecs-barabasi si th f h
Savedr s gufeldi Note € S1z¢ of the
savedecs-vespignaniisi
savedecs-wasserman isi

I /plugin directory.

sampladata

models TARL
Cornell.nsf
Indiana.nsf
scientometrics
nsf Michigan nsf

SciSIP-07-08.nsF

bibtexCoAuthorship.praperties
endnoteCoAuthorship propartiss
isiCoAuthorship properties
isiCoCitation properties
isiPaperCitation propertiss
mergeBibtexAuthors properties

properties mergeEndnoteAuthars. properties r
mergelsiAuthors.praperties &, T
R £:| Radial Tree/Graph (prefuse alpha]‘

mergeScopusAuthors properties
nsfCoPT properties

nsfPITaProject properties = =
scopusCoAutharship.properties [e du.iu.mub.gui.brand_1.0.0 | META-INF

T aeT y

.manager

scopus BrainCancer scopus
florentine nwb

friendister.graphiml aml
socislsciance Friendster.xgmml.aml

. terror .graphml.xml
scripts G“ESEH terror xgmmmi .manager)
Tree {prefuse beta) o |EI|5|

META-INF
META-INF

T TIIIT

FreeHEP WeotorGraphics 1.0.00
0rg.prefuse.lih_2DDBD?'15.D.D) QSG-INF]

[0, wz007O5ZE]

0rg.cisheII.templates.jy‘thonrunner]
[MET A INF)

joda_time_1.0.0] WAETEE
[stax_1.0.0
edu.uciics.jung_1.7.4 META INF

[mg.cishell.en\tironment.equinox.feature]

Notlzed

HUWE Files
Hotlizes Fajek NET Files)\
Motllsed A GMML Files

[featu[es\‘du.iu.nwh.javaalgorithm.feature]

[edu.iu.nuub.con\rerter.feature_'l.D.D)

\[org.cishell.feature_1 .D.D)

[olg.cishell.reference.gui.feature)

eduiu.mmb.gui.brand.feature_1 .D.D]

[org.cisheII.reference.feature_1.D.D:I
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Sci2 Tool — Visualize Workshop Attendees

Use File > Read’ to load Se1S Conf SINA Registrants report 4.10.11-clean.csv

A | B | C
1 |Last Hame Org Organization-Cleaned
2 |Agoulnik edu Brigham and Women's Hospital, Harvard Medical Schoal
_3 |Amaral edu Marthwestern University —
4 |Bates edu University of lllinois at Chicago W Sei2 Tool
_5 |Bennett gov MIH File [Data Preparation ] Preprocessing  &nalysis |
B |Bietz edu University of California, Irvine
_7 |Bishop edu University of Tennesses (=W Rernowe IS Duplicate Records
ELutrecchiann ory,edu George Washington University ey Remove Rows with Multitudinous Fields
10 |Lusina ca,edu Centre for Hip Health & Mobility The .
Sriel Extract Directed Metwark
Mati Extract Bipartite Metwork
b
¢ . . . b Extract Paper Citation Mebwork
Run ‘Data Preparation > Extract Bipartite Network for "
" . 5| Extract Bipartite Netnark
With parameter values: et parte Network | =
Extract a bipartite network from two columns in the table, If the

colurnn values may list multiple entries, enter the special text
which delimits thern,

First colurnn (Last Hame -
Optional: Calculate Node Degree secondcolumn [ (@]
Text Delimiter ]
Aggregate Function File  Ci/Users/User/Desktop/NVWB-Scidfsciz-v0.5-lpha
Visualize resulting ‘Bipartite network

from Last Name and Org’ using ‘1 isualization > Network > GUESS” and
Tayout > GEM’, Tayout > Bin Pack’
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Sci2 Tool — Visualize Workshop Attendees

Use File > Read’ to load Se1S Conf SINA Registrants report 4.10.11-clean.csv

A | B | C
1 |Last Hame Org Organization-Cleaned
2 |Agoulnik edu Brigham and Women's Hospital, Harvard Medical Schoal
3 |Amaral edu Marthwestern University —
4 |Bates edu University of lllinois at Chicago W Sei2 Tool
_5 |Bennett gov MIH File [Data Preparation ] Preprocessing  &nalysis |
B |Bietz edu University of California, Irvine
_7 |Bishop edu University of Tennesses = Rernowe IS Duplicate Records
ELutrecchiann ory,edu George Washington University el Remove Rows with Multitudinous Fields
10 |Lusina ca,edu Centre for Hip Health & Mobility The .
Srie Extract Directed Metwark
Mati Extract Bipartite Metwork
b
¢ . . . b Extract Paper Citation Mebwork
Run ‘Data Preparation > Extract Bipartite Network for "
. . 5| Extract Bipartite Metwark (=3
With parameter values: .- _
Extract a bipartite network from o colurns in the table, If the

column values may list multiple entries, enter the special text
wehich delirits thern,

First colurnn [Last Matre v]

Optional: Calculate Node Degree oo C°'“m@a”'m”'c'em D) (@)
Text Delirniter —

Aggregate Function File Ci/UsersfUser/Desktop/MNWE-Sci2fsci2-vil5-alpha
Visualize resulting ‘Bipartite network

from Last Name and Org’ using ‘Visualization > Network > GUESS” and
Tayout > GEM’, Tayout > Bin Pack’
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Sci2 Tool — Visualize Workshop Attendees

o o ©.%° o
'. . '.' Stanford Univas'lty .

e O ®
@ © Lniversiy of Central Florida
. . Morthwestern University .

e
l. .. .. . Indiana University

. . .Uni\.rersity{}fCalifnrnia, Irvine

O @
e O

.ThclrnsclnReuters

o L] @ (ONN
e O o) ©
Kemin Industries

.' Purdue UniTersity

. lLLast Name
O Affiliation
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Sci2 Tool — Visualize SciTS Co-Author Network
Based on Holly’s EndNote File

Open Holly’s ScZ'TS-Library-03-04-2011.enl’ in EndNote and save as S/ TS-Library-03-

04-20171.enw’ following instructions on
http://cishell.wiki.cns.iu.edu/Endnote+Export+Format

Use File > Read’ to load S TS-Library-03-04-2011.enw’
Run ‘Data Preparation > Extract Co-Occurrence Network’

; : lth parameter Vﬂlues. 5| Extract Metwark from Tahle [5]
Extracts a netwark from a delirnited table
Column Mame Suthars v] ’ﬁ]
Text Delirniter |

Optional: Calculate Node Degree

Visualize resulting ‘Bipartite network
from Last Name and Org’ using ‘Visualization > Network > GUESS” and

Tayout > GEM’, Tayout > Bin Pack’
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A ol or o Sci2 Tool — Visualize SciTS Co-Author Network
Based on Holly’s EndNote File

ence ofgclence
@arch & practice

Network Analysis Toolkit INAT) was selected.

Implementer(s): Timothy Kelley

Integrator(s): Timothy Kelley

Reference: Robert Sedgewick. Algorithms in Java, Third Edition, Part 5 - Graph
Algorithms. Addison-Wesley, 2002. ISBN 0-201-31663-3. Section 19.8, pp.205
Documentation: .
http:/ /wiki.cns.iu.edu/display/ CISHELL/ Network+Analys1s+Toolk1t+%28NAT%29
This graph claims to be undirected.

Nodes: 706 E,
Isolated nodes: 100 . = . . 2 n e
Node attributes present: label - . "y
Edges: 1687 T = " . “r.--‘,.‘.-‘_.‘
No self loops were discovered. . . g
No parallel edges were discovered.

5 of -

Edge attributes:
Did not detect any nonnumeric attributes.
Numeric attributes:

minmaxmean W T 3?4
weight  151.15412 A . &
This network seems to be valued. ! . @_.
w
Average degree: 4.779 o - #

This graph is not weakly connected.

There are 223 weakly connected components. (100 isolates)

The largest connected component consists of 73 nodes.

Did not calculate strong connectedness because this graph was not directed.

Density (disregarding weights): 0.0068
Additional Densities by Numeric Attribute
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research & practice

Sci2 Tool — Visualize SciTS Co-Author Network
Based on Holly’s EndNote File

Largest “Giant” Component

O . R.w. OI"."lc-ser, R.
O%@%g@d %'E.quuist, M.

.% Eﬂ OBerger, M.

! Fir::l:lelng, Le J
;:?D Taylor, Bk 7O GoraQ) Feng, A
0 © X
@ 4
o Stokals, D.
Ol'l.ﬂisra, 5.
o O
@ Trachim, W ,
OEaezﬂde@aQﬂnaﬂ, L.
@] k.
a OF'E Q@gl 'Fuqua, J.
O colty, 57 M.
O Unger, J.

.M |- e
e UBHEWE}T, R.

Owm. B b

Q GQD

o
Lo/ 0 5
o 0O - -
8] e Weak Component Cluster of 73 nodes
o :,'. Metweark with degree attribute added to node list.d
O'Maser, R P. £, Weak Component Cluster of 50 nodes

Weak Component Clustering w
Implementer(s): Russell Duhon
Integrator(s): Russell Duhon
Documentation:

http:/ /wiki.cns.iu.edu/display

£, Weak Component Cluster of 33 nodes
£, Weak Component Cluster of 25 nodes
:,'. Wi¥eak Cormponent Cluster of 17 nodes
£, Weak Component Cluster of 14 nodes
£, Weak Component Cluster of 12 nodes
£, Weak Component Cluster of 12 nodes,?
:,'. Wi¥eak Cormponent Cluster of 11 nodes
%, Weak Corponent Cluster of 8 nodes

Input Parameters:
Number of top clusters: 10

223 clusters found, generating graphs for the top 10 clusters.

Node Degree was selected.

Implementer(s): Timothy Kelley

Integrator(s): Timothy Kelley

Documentation: http://wiki.cns.iu.edu/display/ CISHELL/Node+Degtee

GUESS was selected.
Author(s): Eytan Adar

Implementer(s): Eytan Adar (GUESS), Russell Duhon (resizeLinear, colorize fix)

Integrator(s): Russell Duhon

Reference: Adar, Eytan, "GUESS: A Language and Interface for Graph Exploration,”
CHI 2006 (http://graphexploration.cond.otg/)
Documentation: http://wiki.cns.iu.edu/display/ CISHELL/GUESS
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Sci2 Tool — Visualize SciTS Co-Author Network
Based on Holly’s EndNote File

O
oo o
. Falk-kizesinski, Hollyd:
o O . Stokole-Daniel o
O O . Hall, Kara L. 8]
0 Spring, Bonnie

'. Finrel itephen M o

o Trochim, Willia
0 O . m. Uzzi, Brian

., Borner, Katy Contractor, Noshir ©

Keyton, Joann
o (9]

o o O p °
0O °
Q
o

4 57, Weak Component Cluster of 73 nodes
i:'. Metwrark with degree attribute added to node list.4
%2, Weak Component Cluster of 50 nodes
%2, veak Cormponent Cluster of 33 nodes
%2 viveak Cormponent Cluster of 25 nodes
i:', Weak Component Cluster of 1T nodes
%2, Weak Component Cluster of 14 nodes
%2, veak Cormponent Cluster of 12 nodes
%2 viveak Cormponent Cluster of 12 nodes.2
i:', Weak Component Cluster of 11 nodes

%2, Weak Component Cluster of 8 nodes

BO2 | Stipelman, B. 589 *

603 | Stokols, D 200

E04 | Stokals, Daniel Fi=

B05|Stone, Anthony R. BOE *

BOG | Stringer, b j. BOG ™

G607 | Subramanian, 5. tatase A

03| Sundstrom, Eric 219"

B09| Sung, M. 611

B10|Sung, WS B2a

B11|Syme, 38| Tress, . BE1*
639 | Trochim, W 595 *
G40 | Trochirm, W, k. 408 *
G471 | Trochirm, W k. 43 *
G642 | Trochim, W m. 444 *
B43 | Trochirm, William B
B44 | Trochirm, William k. k. BEE *
B45|Unger, J. 588 7
B4G|Lzzi, B. 346
G47 (Uzzi, Brian B3 *
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o ? Workshop Overview

1:15 Marcoscope Design and Usage & CIShell Powered Tools: NWB & Sci2
1:45 Sci2 Tool Basics
» Download and run the tool.

2:00 Sci2 Sample Workflow: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

2:30 Sci2 Sample Workflow: Studying Four Major NetSci Researchers.

» Load and clean a dataset as text file; process raw data into networks.
»  Find basic statistics and run various algorithms over the network.

> Visualize as either a circular hierarchy or network

3:30 Break

4:00 Sci2 Demo I: Geospatial maps with congressional districts

4:30 Sci2 Demo 1I: Evolving collaboration networks

4:45 Outlook and Discussion

5:00 Adjourn

41



Padgett's Florentine Families - Compute Basic
Network Properties & View in GUESS

Florentine families related through business ties (specifically, recorded financial
ties such as loans, credits and joint partnerships) and marriage alliances.

Node attributes
Wealth: Each family's net wealth in 1427 (in thousands of lira)

Priorates: The number of priorates (seats on the civic council) held between
1282- 1344

Totalties: The total number of business or marriage ties in the total dataset of
116 tamilies.

“Substantively, the data include families who were locked in a struggle for political
control of the city of Florence around 1430. Two factions were dominant in this
struggle: one revolved around the infamous Medicis, the other around the
powerful Strozzis.”

http://svitsrv25.epfl.ch/R-doc/library/ergm /html/florentine.html
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Padgett's Florentine Families - Compute Basic
Network Properties & View in GUESS

> Load *yoursci2directory*/ sampledata/ socialscience/ florentine.nwb
» Run ‘Analysis > Network Analysis Toolkit (NAT)’ to get basic properties.

This graph claims to be undirected.

Nodes: 16

Isolated nodes: 1

Node attributes present: label, wealth, totalities, priorates
Edges: 27

No self loops were discovered.

No parallel edges were discovered.

Edge attributes:

Nonnumertic attributes:

Example value

marriag... T

busines...F

Average degree: 3.375

There are 2 weakly connected components. (1 isolates)
The largest connected component consists of 15 nodes.
Did not calculate strong connectedness because this graph was not directed.
Density (disregarding weights): 0.225

> Select network and run Visualization > GUESS’ to open GUESS with file loaded.
» Apply Layout > GEM’.



El cansole =0

=10l x|

=]
b 8

LUESS was selected.

uthor{s): Evtan Adar

mplementer(s): Evtan Adar (GUESS), Russell Duhon (resizelinear, colarize Fix)

ntegrator{s): Fussell Duhon

eference: Adar, Evtan, "GUESS: & Language and Inkerface for Graph Exploration,” CHI 2006 (hiktp:/ /graphexploration.cond.org,}
ocumentation: https://nwb.slis.indiana.edu/community /?n=YisualizeData.GUESS

CHO is off,

he initial layout For wour visualization is random. For a clearer visualization, please run a lavout from the Layvouk menu. (We recommend GEM.)
CHO is off,

UESS log File For this session can be found in

ADQCUME -1 kabyi LiOCALS~ 1 TemptCIShel-Session-558921 SkaticEx ecut ableR unner -55904 ALEORITHM quesslog. Exk

llllllllll L] ‘- 1 i i -
LESS was selectad, | -¥Wisualization - GUESS

uthar(s): Evtan Adar | Ele  Edit Layout Soript Yiew  Help

rteqratar(s): Fussell Duke Medici-Acciaiuoli

W

eference:; Adar, Evtan, " | =
ocumentation: https://1| 5 Field Value
CHO is off, g _ edgeid o
tartin_g GUESS c business =
E;'?'liltsiaﬁ;fout for wour E cplur dandeiion
CHO is off, = |directed False
LESS log File For this sess E |label
ADOCUME -1 ikabyiLOCh labelcalor 0,0,0,255
labelsize 12
El 5cheduler labelvisible false
marriage T

Remove From List | [ F node1 n3
nodeZ nl

m visible true
weight 1.0

| [ Algorithm | Mdth 20

GUESS

GUESS
|| Node Betw
|| Mebwork Ar
|| Load...
|| GruPlot
|| GnuPlok
+'| Degree Dis
|| Barabdsi-a
|| GRuPlok
| Degree Dis Mode Shape Center Change Hiskary
+| GUESS
|| Load...

Object: | Property: Operator:

Colour Show Hide Size Show Label Hide Label

L= L=

Interpreter . Graph Modifier

] . MWE File: C:iDocuments and SettingsikatyiC
P pistribution of degree For netwark at ste

] , List of edges of network created through the
1 pistribution of degree For netwark at ste
{4/ Distribution of degree For nebwark at ske

= . WWE File: Ci\Documents and SettingsikatyiC
:‘. araph and Mebwork Analysis Log
:—_ Sequence of sike betweennesses for noc
P pistribution of site betwesnngss For nety
14" Distribution of site betweenness For nety

=

=« MWE file with site bebweenness attribuke

=101

Yalue:

Zhange Label
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' ¥Yisualization - GUESS

File Edit  Lawout

Scripk Wiew  Help

[ InFarmation \Window

Medici
Field | Yalue

color cornfla...
Fized False
height  10.0
irnage:
label Medici
labelcolor 0,0,0,...
labelsize 12
labelvi... False
rarne n9

original... Medici
priarates 53

stroke. .. cadeth...

shyle Z
kotalities 54

wisible  krue
wealth 103
widkh 10.0

k4 an.625...
y 44,312,

4
r

LN+

n r
i conteron

Colar, ..

Remowe

Add

Modify Field. ..
Copy as Yariable, ..

R RE

Inkerpreter |, Graph Mu:udifier/."l

Dhjeck; | |v| Property: | labelsize = | Operator: Yalue: EI

| colowr || Show || Hide || See || Showlabel || Hidelabel || Changelabel |
| FormatNode Labels | | Format Edge Labels |
| Modeshape || Cemter || ChangeHistory |
| Resizelinear | | (olorize |
(Nodes = [labelsize | From: | | Ta: | || Do Resize Linear

_[olx| Pan:

“grab” the background
by holding left-click
and moving your
mouse.

Z.oom:

Using scroll wheel,
press the “+” and “-”
buttons in the uppet-
left hand corner, or
right-click and move
the mouse left or right.
Center graph by
selecting ‘View ->
Center’.

Select @1 to
select/move single
nodes. Hold down
‘Shift’ to select
multiple.

Right click to modify
Color, etc.
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! -Wisualization - GUESS

=10l x|

File Edit Layout Script  Yiew  Help
Pucci :
_§ Field | Value J
g color 255,25,
= fixed false
& heiht 5.0 3 Castellani)
= |image N
£ |label Pucci Barbadorr) Ginari:)
— llabelcalar 0,0,0,... Lamb ! ]
labekize 12 ami SHESSL Peruzzt) - Salviati)
labelvi... true % . Albizzi)
narme niz r
ariginal. .. Pucci ] ' Strazzi) Pazzi)
priorates 0 Bischeri’) Ridaolfi:) N )
stroke... cadeth... Q Guadagni) Medici:)
stwle z )
totalities 1 Tarnabuoni’ Acciailol)
visible  true O '
wealth 3 m
width 5.0
E4 15.0
b #1.100... ri-i Pucei)
-

e — T —— T

| Calaur || Shiow || Hide || Size || Show Label || Hide Label || Change Label |

Interpreter , Graph l\'h:u:IiFier/"I

|| Format Mode Labels ||| Formnat Edge Labels |

| Mode Shape || Center || Change History |

| Resize Linear || Colorize |

Graph Modifier:

Select “all nodes” in the Object
drop-down menu and click ‘Show
Label’ button.

Select ‘Resize Linear > Nodes >
totalities” drop-down menu, then
type “5” and “20” into the From”
and To” Value box separately.
Then select ‘Do Resize Linear’.

Select ‘Colotize>
Nodes>totalities’, then select
white and enter (204,0,51) in the
pop-up color boxes on in the
“From” and “To” buttons.

Select “Format Node Labels”,
replace default text {originallabel}
with your own label in the pop-up
box ‘Enter a formatting string for
node labels’
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Yisualization - GUESS -0 x|
File Edit Lawout Script  Wiew  Help

1 Acciaiuoli:) :
E Field | Walue o
g color 255,24,
g [fixed False
) |height 5.6635... O Castellani;)
= (image o
u._E. label Acciaiu, .. Barbador) Ginori’)
— |labelcolor 0,0,0,... Lamb | )
labelsize. 12 am 1 Peruzzi) o Salviati)
labelvi... Erue % Albizzi:)
1
na.m.e i P Strozzic)
original. .. Acciaiuoli ) ' Pazzi)
priorates 53 Bischer) Ridaolfi:) o '
stroke, .. cadeth... Q Guadagni) Medici)
shyle 2 ’
kotalities 2 Tarnabuonic) Acciaiuoli)
wisible  true '
wealth 10 m
width 5.6635...
% 112.01...
70.315... -
L m Pucci) Interpreter:
Uses Jython a combination of Java
‘ and Python.
F .
== resizeLinear(totalities, 5,20)
== colorize{wealth,white,red) Try
EE
colorize(wealth, white, red)
[ Interpreter j raph Mu:udiFier/.-"




Q Workshop Overview

1:15 Marcoscope Design and Usage & CIShell Powered Tools: NWB & Sci2
1:45 Sci2 Tool Basics
» Download and run the tool.

2:00 Sci2 Sample Workflow: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

2:30 Sci2 Sample Workflow: Studying Four Major NetSci Researchers.
» Load and clean a dataset; process raw data into networks.

» Find basic statistics and run various algorithms over the network.
» Visualize as either a circular hierarchy or network.

3:30 Break

4:00 Sci2 Demo I: Geospatial maps with congressional districts

4:30 Sci2 Demo 1I: Evolving collaboration networks

4:45 Outlook and Discussion

5:00 Adjourn
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+ | Studying Four Major NetSci Researchers (ISI Data)
“ws8 using Database (section 5.1.4)

Time frame: 1955-2007

Region(s): Miscellaneous

Topical Area(s): Network Science

Analysis Tvpe(s): Paper Citation Network, Co-Author Network, Bibliographic

Coupling Network, Document Co-Citation Network, Word Co-
Occmrrence Network

Thomson Reuter’s Web of Knowledge (WoS) is a leading citation database. Access it
via the “Web of Science” tab at http://www.isiknowledge.com (note: access to this
database requires a paid subscription). Along with Scopus, WoS provides some of
the most comprehensive datasets for scientometric analysis.

To find all publications by an author, search for the last name and the first initial
followed by an asterisk in the author field.

http:/ [ sci2.wikis.cns.inedu/ 5.1.4+S tudying+ Four+Major+NetS ci+Researchers+ (1S 1+ Data)
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ol for

| Data Acquisition from Web of Science

séa:r_t_:h & practice

&) ISI Web of Knowledge [v3.0] - Netscape _|EI 5[
. File Edit Yiew Go Bookmarks Tools Window Help

In Dec 2007, We downlo aded o @0 Q @ @ \ http:/fpartal. isiknowledge. comjpartal, coi?DestApp='\WOS&Func=Frame | =

‘;‘f E.\'_‘ 4% Home [My] Netscape G 5earch| % Customize.,. 5 [~spraoffg=t...

aH pap ers by . @ Netscape - |Enter Search Terms |V] 4 Search ¥ Highlight P FormFil = 7 Clear Browser Histary %News EAEmail 3

“£] New Tab | % 15T web of Knowledge [v3.0] w

1S Web of Knowledge* [ hoE |
» Eugene Garfield

Web of Science® =
| Rrwecome| | 2 wew | (O prmaner] | o ceaecs | | povancen]
> Stanley Wasserman General Search
Select database({s) and timespan:
> A 168 Sandro ‘ ] es 1 nam Citation Databases:  Latest [1 week =] {updated December 09, 2007)
[¥ i) Science Citation Index Expanded (SCI-EXPANDED)--1955-present € vear [z007 =]
¥ i) Social Sciences Citation Index (SSCI)--1956-present @ From 1555 1 to [2007 2] (default is all years)
; ! 1bert Lé’szlé Barabé’si ¥ i Arts & Humanities Citation Index (ABHCI)--1975-present To remember these settings, first sign in or register,
Enter terms or phrases separated by the operators AND, OR, NOT, or SAME, and then press SEARCH. View our General Search tutorial
The search will be added to the search history. [=> View your search history/combine sets]
from
TOPIG: i) Enter one or more terms. Searches within article titles, keywaords, and abstracts. =
Exampie: oil spill* AND "Morth Sea" (How to search for phrases)
» Sci Citation Ind | e
C e Ce a O e /| AUTHOR: i) Enter one or more author names (see author index ).
Example: O'BRIAN C* OR OBRIAN C*
EXpanded (S‘ I_E k_ PANDED) Author Finder: Meed help finding papers by an author? Use Authar Finder.
GROUP AUTHOR: i) Enter one or more group names (see group author indes ),
1 9 5 5 Exarnple: CERN
p SOURCE TITLE: i) Enter full journal titles (see full source titles list =),
Exampde; Cancer* OR Journal of Cancer Research and Clinical Oncology
SOC SC e CeS a O de PUBLICATION YEAR: i) Enter a publication year or range.
SS I 1 9 5 6 Example: 2001 or 1997-1999
( ) p ADDRESS: i) Enter abbreviated terms from an author's affiliation {use abbreviations help),
Example: Yale Univ SAME hosp
Restrict search by languages and document types:
All languzges topmz |
English ] |Article
n eX [— —present Afrikaans |=] |abstract of Published Iterm
SRASF D] = |
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Comparison of Counts
&1 No books and other non-WoS publications are covered.

Age Total # Cites Total # Papers H-Index

Eugene Gartfield 82 1,525 672 31

Stanley Wasserman 122 35 17

Alessandro Vespignani 42 451 101 33

Albert-Laszl6 Barabasi 40 2,218 126 47 (Dec 2007)
41 16,920 159 52 (Dec 2008)

44 30,102 201 68  (April 11)
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Extract Co-Author Network

Load*yoursci2directory™/ sampledata/ scientometrics/ isi/ FourlNetS ciResearchers.isi’

using 'File > Load ...°
And file with 361 records appears in the Data Manager.

Duplicates were removed, author names normalized. Log file exists.

f

\% Sei? Tool f=E =S
File Data Preparation Preprocessing  Analysis  Modeling  “Wisualization  Help
El Cunsole‘ = B || Data Managerl =0
Loaded 361 records. B IS Data: CiUserstsenDesktoph10-MEH-A&H-Workshop
Removed 0 duplicate records, 361 Unique IS Recards

Author narmes have been normalized,

361 records with unique ISIIDs are available via Data Manager.

Wirote log to
ChllsersiUserdppDatatlocalhTernphisiduplicaterernoverlog2534733993422022
il @
(=
= Scheduler‘ =B

Remavwe Fram List | [[] Remove completed automatically | Remawe all camplete

! Algorithm Mame Date Time %

] Load and Clean IS File 081552010 07:29:43 PM -

[ Load and Clean ISIFile 081572010 07:12:49 Phd
4| I |




Extract Co-Author Network
(see section 5.1.4.2 on corvecting duplicate/ misspelled anthor names)

To extract the co-author network, select the 367 Unigue IS1 Records’ table and run
‘Data Preparation > Extract Co-Author Network’ using isi file format:

Il Extract Co-Author Ne x|

Extracts a co-authorship netwark From one of several supported file
[vpes,

File Format Iisi |

O Cancel |

The result is an undirected but weighted network of co-authors in the Data Manager.

Run ‘Analysis > Network > Network Analysis Toolkit (NAT)’ to calculate basic
properties: the network has 247 nodes and 891 edges.

Use ‘Analysis > Network > Unweighted and Undirected > Node Degree’ to calculate the number
of neighbors for each node independent of co-authorship weight.

To view the complete network, select the ‘Extracted Co-Authorship Network’ and run
Visnalization > Networks > GUESS”.

Network is loaded with random layout. In GUESS, run T.ayout > GEM’ and ‘Layout
> Bin Pack’ to improve layout. Run 'Seript > Run Seript ..." and select’
yoursci2directory/ scripts| GUESS [ co-author-nw.py'.
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A tool for"

;";E’E‘;ff:;le Co-Author Network of all Four NetsSci Researchers

Eugene Garfield

g 11 amigal LAN

.l_:”':l

Naode Size & Color

Number of |1".||:-|.::~

127

[acobucel, I

Stanley Wasserman

Edge Size & Color
Mumber of Times

Co-Authared

FaoAD
fad
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Co-Author Network of all Four NetsSci Researchers

Use the GUESS Graph Modifier to change
color and size coding.

Calculate node degrees in Sci2 Tool.

Use a graphic program to add legend.

Euge; Garfield

Nade Size & Colar
Number -:}'I'-..| ors

127
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Tice of Science
"

Individual Co-Author Networks
(Read/map 4 files separately)

Alessandro Vespignani

Albert-1.asz16 Barabasi
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Network Visualization:

Node Layout
eo® g .%.
Load and Clean ISI File was selected. & ®e { . :?/e P .:.':.
[ ] ® ] = e . _ ...
Loaded 361 records. o, o o - ag®e "
Removed 0 duplicate records. .-: P2 'y L - '. X
Author names have been normalized. o .. S /ot | .. - o .. *% o
361 records with unique ISI IDs ate available :. ° - . ! 9y .i,. -
via Data Manager. o« ® .'. 4 -y . S N
.......... .-.-‘- ® 9 ® e .'.....
o % a0 ) e o8 o0 00

Extract Co-Author Network was selected. L L 0,9 80 gos0
Input Parameters: %e : :. - . :': o’ ..0.
File Format: isi o te e’
Network Analysis Toolkit (NAT) was selected.
Nodes: 247 °
Edges: 891 o * o, ¢
.......... e \® 9 o .
GUESS was selected. . » A\, /PP o ' o

» °® .o ° - @

® L ]
L . o s ®
s ™ ® .‘. L
. e ® ® o ®
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arch & practice

Network Visualization:

Color/Size Coding by Data Attribute Values

» ®
o0
o .
I @
" | =
A=
. ' e
% 5 Wisualization - GUESS
File Edit Layout Script  Wiew  Help
Vespignani, A :
E Field | Yalue o
=
= color 125,12,17,255
E [fixed False ﬁ':.l.: i -
5 |height 10,0 O - oy Koa .
§ image gt o ®
(Tl . N .. .
Z |label Wespignani, & o
— |labelcalar 0,0,0,255 .
labelsize 12 ™ . . —
labelvisible False (_}& LRt o ® Node Size & Color Edge Size & Color
name nie6l . | & Number of Papers Number of Times
numnberofworks 101 '::: Co-Authored
ariginallabel Wespignani, & ._..;1 127
strokecolor black. g % ‘ 4
style z [ ] 15 9
kirnescited 3511 1
wisible krue s | 52
whh oo e B
k4 586,75
v 10775 1 15 1 33



Network Visualization:
Giant Component

Weak Component Clustering was selected.
Implementer(s): Russell Duhon
Integrator(s): Russell Duhon

Input Parameters:
Number of top clusters: 10
3 clusters found, generating graphs for the top 3 clusters.
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Network Visualization:
Color/Size Coding by Degree

Atoolfor
S A 7,
nce ofgclence
> “‘r_esé'a:rch & practice

Node Degree was selected.

Documentation:
https://nwb.slis.indiana.edu/community/?n=AnalyzeData.No
deDegree .
[ ]
® ' ®
.......... e
- L &
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Network Visualization:

Color/Size Coding by Betweeness Centrality

s "* .}’)..'
L " "—{. e ]
[ T /}f L0
< < e ® / [ Bl )
- - P \ s
Y - G 'I ’
- : 3 A azquez, A

~_= Pastor-satoffas, R
[ ]

Node Betweenness Centrality was selected. .
Authot(s): L. C. Freeman

Implementer(s): Santo Fortunato

Integrator(s): Santo Fortunato, Weixia Huang

Reference: Freeman, L. C. (1977). A set of measuring centrality

based on betweenness. Sociometry. 40:35-41. -

Input Parameters: Sl /
Number of bins: 10 . T

A

e
-

umber of bins: 10
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Network Visualization:
Reduced Network After Pathfinder Network Scaling

"%y sMakeay, MA =

L ]
- . ¥
.".I'I:ralg T . - 'gi'lhh' HE

.'!
. " .
" ®Jeong, H "
L] L] "
sHwin, § |
'_" + #kahng B
- -
. .y . : L . -
[ L - -
- .
K * o .
-

.o ’ & ®Pasior-saioras. Re sloreo, V
®0Rval, IN ; ‘;ﬁ :
r ] l'M';IQT.H:T.ﬂ . 'l" = . - w
SRR @Pistroneo, L :
] I § sBarthalamy, M
. s 3\ ®Barat, A

MST-Pathfinder Network Scaling was selected. . 4 )
Input Parameters: A
Weight Attribute measures: SIMILARITY _' .

Edge Weight Attribute: weight



Network Visualization:

Circular Hierarchy Visualization

Select Co-Author Network and run Blondel Community detection:

File Data Preparation Preprocessing Modeling  Wisualization  Help

El consale Temporal r = B il Data Manager

""""" SrospEal g ||| a 7151 Data: CaAUsers\UserDesktop10-NEH-AaH-WorkshopADYDAsci s ampl

Load and Clean I5I File was selected,

. , - _
Author(st Micah Linnemeier Vieppien) 4 77 361 Unique ISI Records
Irmplementer(s): Micah Linnemeier Metniorks 3 Metwork Analysis Toolkit (MAT) h
Inteqrator(s): Micah Linnemeier MetsciFesearchers.as
Docurnentation: Urwveighted & Undirected P ole rreraed
Il:lttpds:.fd.fnwh.slls.lndlana.edu.fcnm munityf!n=LoadData.ISILoadAr Weighted & Undirected ’ Clustering Coefficient
oaded:
CiUsersyUsertDesktapi10-MEH-A&H-WarkshoptDWDhsciZsample Ureighted & Directed ¢ Mearest Meighbor Degree
ometricshisivFourMetSciResearchers.isi \eighted & Directed v Strength vs Degree
Loaded 361 records, | P £ ISl Data: C:I‘-_Lalsers‘-LLlse Llegiiee & STERGED
Remowved [ duplicate records. 4 |:_'| 361 Unigque IS Rec Arverage Wieight ws End-poaint Degree

Author names have been normalized.
361 records with unique ISLIDs are available wia Data Manager. |:_-| Author i
Wifrote log o

ChlUsers\UserBppDatatLocahTemphisiduplicaterernowverlogdfr35223958971021
ITh et

%, Extracted Co-£

nfarm

Strength Distribution
Wéeight Distribution
Randormize Weights

Blondel Carmmunity Detection

Wlth pﬂrameter Values A Blandel Comrmunity Detection

This algorithr implements Blondel's cormmunity detection
algarithrn,

Wieight ’numbernfcnauthuredwurks '] "9]
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Network Visualization:
Circular Hierarchy Visualization

Visualize resulting file using ‘1VZsualization > Networks > Circular Hierarchy’
with parameter values

e

5 Circular Hierarchy @

Provides Circular Hierarchy Visualization on the netweark,

Degree of Edge Bundling  0.75

Node Strength Column [timescited - | ||
Level 0 | blondel_comrmunity_level 8 | | 4|
Level 1 |blondel_community_level 1 | | 4|
Level 2 |blondel_community_level 2 | | 4|
Level 3 (Mo Level -| |4

Edge Weight Colurmn ’numhernfcnauthnredwurks Tl "ﬁl

Mode Colar Column ’numhernﬁmnrks "l I'ﬁl

MNode Color Range ’Green to red "l I'ﬁl

[ ak. ][Eancel]




Network Visualization:
Circular Hierarchy Visualization

Nodes that are interlinked/clustered e =
are spatially close to minimize the :
number of edge crossings.

Node labels, e.g., . .:__:ff'

author names.

Network structure m— —
using edge bundling. H =

Color coded cluster ?

hierarchy according to A

Blondel community

detection algorithm. Mode Calor

bazed oo MUMBEROFWORES attribate

1 g4 127

Note:

Headet/footer info, legend, and more meaningful color coding are under development. .



Paper-Citation Network Layout

To extract the paper-citation network, select the 367 Unigue IST Records’ table and run
‘Data Preparation > Extract Paper Citation Network.

The result is a unweighted, directed network of papers linked by citations, named
Exctracted paper-citation network in the Data Manager.

Run NAT to calculate that the network has 5,342 nodes and 9,612 edges. There are
15 weakly connected components. (0 isolates)

Run ‘Analysis > Networks > Unweighted and Directed > Weak Component Clustering’ with
parameters

- . — ; -
] . L Wieak Component Cluster of 5151 nodes
5 [ Meak Component Clustering [E3m] L2 P
o 5 Weak Component Cluster of 38 nodes
Creates news graphs containing the top connected components, @

5w Weak Component Cluster of 35 nodes

%, Weak Component Cluster of 27 nodes

Nurmber of top clusters  10] # %2, Weak Component Cluster of 27 nodes.2

E:', Weak Component Cluster of 15 nodes

to 1dentify top-10 largest components. The largest (giant) component has 5,151 nodes.

To view the complete network, select the network and run ‘Visualization > GUESS".






arch & practice

Topic Mapping: UCSD Science Map

Science Map via Journals for FourNetSciResearchers.isi

314 journal references matched out of 361 found.

These 314 references are associated with 13 of 13 disciplines of science and 255 of 554 research specialties in the UCSD Map of Science.

Earth Sciences

A Srience Map (=3
Locate the journals frorm a table on the UCSD Map of Science

lournal colurmn Journal Mame (Abhreviated)

Dataset display name  FourMetSciResearchers.isi

C; 0 Anfections Disease
5
o
P
@\) Biology

Health Professionals

Data:

WoS and Scopus for 2001-2005, 7.2 million
papers, more than 16,000 separate journals,
proceedings, and series

Similarity Metric:
Combination of bibliographic coupling and
keyword vectors

Number of Disciplines:

554 journal clusters further aggregated into 13 main
scientific disciplines that are labeled and color
coded in a metaphorical way, e.g., Medicine is

blood red and Earth Sciences are brown as soil.
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How to Read the UCSD Map

i s o B0 ol bt il

Tomar 117 sl wrrrmes sar sesarivard wvb 11 @ 11 S

UCSD Science Map

with data overlay. —— ‘ e

Map legend of ——
circle area size
coding

Listing of all data —
records organized int
UCSD science areas.

-+ 'y A H i S’ - T Pl e

Seiencs Map via fourmals ee NIH-UTRA - Publisasons o

AN

A

Circle of non-located,
e.g., ‘Unclassified’
records.

Header and footer with
information when this
map was created, by
whom and using what
data set.

Listing and circle of
non-located, e.g.,
‘Unclassified’ records.
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Break




O 2 Workshop Overview

1:15 Marcoscope Design and Usage & CIShell Powered Tools: NWB & Sci2
1:45 Sci2 Tool Basics
» Download and run the tool.

2:00 Sci2 Sample Workflow: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

2:30 Sci2 Sample Workflow: Studying Four Major NetSci Researchers.

» Load and clean a dataset as text file; process raw data into networks.
»  Find basic statistics and run various algorithms over the network.

> Visualize as either a circular hierarchy or network

3:30 Break

4:00 Sci2 Demo I: Geospatial maps with congressional districts
4:30 Sci2 Demo 1I: Evolving collaboration networks

4:45 Outlook and Discussion

5:00 Adjourn
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Sci2 Demo I:
Geospatial maps with congressional districts

1
2
3
4
5
]
7
8
9

10
11
12

A

Zip code

90095
4672
232980568
10032
10039242
45091500
191112434
27705
981959472
10065
10065

A

g ! EZi[::r code Congressional District Latitude
2 90095 CA-30
3 4672 ME-02

4 | 232980568 VA-03

B

= Identity Congressional District, Latitude, Longitude

C D

Longitude

34.0735035 -118.6645815
45.818717 -65.0290345
37.270472  -77.0699835

Aggregate/Count identical Congressional Districts

QL[ T

O

@

A | &8 | ¢ | D |
1 |Congressional District  Latitude Longitude Count
_2 |CA3N 34.0735035 -118 6645815 4
3 |MED2 45818717 -69.0250345 2
4 WADS 37270472 77 ORSSEE5 1
_ A [NY-14 40.8341475  -73.5342005 4

O O

& BRI

0.3

£
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Relevant Sci2 Manual entry

Home

1 Introduction

2 Getting Started

3 Algorithms, Tools,
and Plugins

4 Workflow Design

5 Sample Workflows
5.1 Individual Level
Studies - Micro
5.2 Institution Level
Studies - Meso
= 5.3 Global Level
Studies - Macro
5.3.1 Geo USPTO
(SDB Data)
5.3.2 Congressional
District Geocoder

G Sample Science
Studies & Online
Senvices

7 Extending the Sci2
Tool

8 Relevant Datasets
and Tools

9 References
Appendix 1 Glossary
Appendix 2 ClShell
Algorithms

Appendix 3 Sci2
Release Motes v0.5
alpha

@ Tools -

9.3.2 Congressional District Geocoder

& 14 Added by Scott Weingart, last edited by Ted Polley on Mar 28, 2011 (view change)

zip code.csv

Region(s): United States

Analysis Type(s): Geospatial Analaysis
To visualize Congressional Districts you must first extract that data from a dataset containing either ZIP codes or
addresses. You can download the Congressional District Geocoder plugin here. You can load any file that contains
9-digit U.S. ZIP codes to be geocoded. A sample file can be loaded by using ‘File = Load" and following this path:

'yoursic2directory/sampledat/geo/zipcode. csv'. Load the file in Standard csv format.Then select the file in the data
manager and use "Analysis = Geospatial > Congressional District Geocoder' with the following parameters:

= | B ) |

Converts U5, ZIP codes to congressional districts

-
&% Congressional District Geocoder

Place Name Column [Zin code | ']

(=)=

S-digits ZIP codes with multiple congressional districts, empty entries and invalid ZIP codes that failed to be geocoded
will list in warning messages on the console The output table contains all columns of the input table with three
additional columns appended: Congressional district, latitude, and longitude. To view the output table save the file
using ‘File = Save...” and selecting the desired save location (to view the file in Excel save it as a csv file). Once the
file has been saved it can be viewed with your choice of program. Below the file has been opened as a csv file:

A B c D
1 Zipcode Congressional District Latitude Longitude
2 90035 CA-30 34.0733035 -118.8645815

hitp:/ [ sci2.wikis.cns.in.edu/ 5. 3.2+ Congressional+ District+ Geocoder
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Relevant CIShell plugin

g:’C I Congressional District Geocoder £ Tools ~
()

&1 Added by Ted Polley, last edited by Chin Hua Kong on Mar 29, 2011 (view change)

Description

(latitude and longitude). The Benchmark is 50,000 ZIP codes per second. Download the plug

This algorithm converts the given 9-digits U.S. ZIP codes (ZIP+4 codes) into its ::ongres !Eland geographical coordinates

Pros & Cons

1.

2.

The algorithm is using a local database mapping with 25MB file size. It will increase the application size dramatically. So it is build
as an external plugin

For first execution in the same application window, the plugin required 5 seconds to load the database. The consequent execution
will not required the pre-loading phase.

Since some 5-digits ZIP codes contain multiple districts, the 9-digits ZIP codes is required for the conversion. Warning message will
be printed to notice user if the given 5-digits ZIP codes contain multiple districts

Congressional district might be varied by each election. The database would need to be maintained and updated relatively.

Applications

This plugin only support U.5. ZIP codes. It convert 9-digits ZIP codes to their belonging congressional district. It is an external plugin since
the data size is so large. The dataset is based on the year 2008 election.

bttp:/ [ cishell.wifei.cns.in.edn/ Congressional+ District+Geocoder
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A tool for . {

scifpce oLeience Console Messages

@arch & practice

Load... was selected.

Documentation: http://wiki.cns.iv.edu/display/ CISHELL/Data+Formats

Loaded: C:\Users\katy\Desktop \NWB-SCI2\sci2-2011.04.04-v0.5a\sampledata\geo\ zip code.csv
Congressional District Geocoder was selected.

Implementer(s): Chin Hua Kong

Integrator(s): Chin Hua Kong

Documentation: https://nwb.cns.iu.edu/community/?n=SampleData.CongtessionalDistrictGeocoder

Input Parameters:

Place Name Column: Zip code

District values added to Congressional District, Latitude and Longitude respectively.

There are 2 rows with "33612" ZIP code, which could not been given a congressional district.
There are 1 rows with "2472" ZIP code, which could not been given a congressional district.
There are 3 rows with "10016" ZIP code, which could not been given a congressional district.
There are 1 rows with "11203" ZIP code, which could not been given a congressional district.
There are 1 rows with "60637" ZIP code, which could not been given a congressional district.
There are 1 rows with "70118" ZIP code, which could not been given a congressional district.
There are 1 rows with "60612" ZIP code, which could not been given a congressional district.
There are 3 rows with "21205" ZIP code, which could not been given a congressional district.
There are 1 rows with "2467" ZIP code, which could not been given a congressional district.
5-digit ZIP codes may often be insufficient, as many zip codes contain multiple congressional districts. 9-digit zip codes may be required. If a
zip code was recently created, it may also not be contained in our database.

Successtully converted 86 out of 100 ZIP codes to congressional districts.
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Sci2 Demo I:

Geospatial maps with congressional districts

Run Preprocessing > General > Aggregate Data’

using parameter values

5| Aggregate Data ==

Agaregate data in the table based on a colurnn,

Aggregate on column | Congressional District |
Zip code [Nane -|
Latitude | Aerage -
Longitude | Aerage -
Delirmiter far Cangressional District |

Note: Need lat/long for geomap.

Input Parameters:

Aggregate on column: Congressional District
Longitude: AVERAGE

Latitude: AVERAGE

Delimiter for Congressional District: |

Zip code: NONE

Aggregated by ": All rows of Latitude column were skipped due to no non-null, non-empty values.

Aggregated by ": All rows of Longitude column were skipped due to no non-null, non-empty values.

Frequency of unique "Congressional District”" values added to "Count" column.
"Zip code" column has been deleted from the output. Since No aggregation was mentioned for it.
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A tool for

arch & practice

= Create Geo Map (Circle Annotation)

Geo Map (Circle Annotations) was selected.

Author(s): Joseph R. Biberstine

Implementer(s): Joseph R. Biberstine

Integrator(s): Joseph R. Biberstine

Documentation: http://wiki.cns.iu.edu/display/ CISHELL/Geo+Map

Input Parameters:

Longitude: Longitude

Size Circles By: CircleSize

Color Circle Exteriors By: None (no outer color)

Color Circle Interiors By: CircleSize

Exterior Color Scaling: Linear

Exterior Color Range: Yellow to Blue

Interior Color Range: Blue to Red

Size Scaling: Linear

Map: US States

Author Name:

Interior Color Scaling: Linear

Latitude: Latitude

14 rows in the table did not specify all values needed to make a circle; those rows were skipped.
Printing PostScript..

Done.

Saved: C:\Users\katy\Desktop\geoMaps2903082942930990749.ps

Save ps file, convert to pdf, view.

P

5| Geo Maps (circles) (=3

Creates a map with circle annotations, Circles are positioned,
sized, and colored {inside and outside) according to columns in
the input table, Either or both kinds of coloring can also be
disabled, The table data for each dirmension can be log-scaled
befare processing.

Map [US States v] e

Author Narme K. Bormer
Latitude | Latitude -
Langitude |Longitude -
Size Circles By | Count -
Size Scaling [Linear - 1
Calor Circle Exteriors By [Hone (no outer calor) |
Bxterior Color Scaling | Linear -
Beterior Color Range | Yellow to Blue -

Color Circle Interiors By [Count v] 4

Interior Color Scaling [Linear v]
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How to Read the Geo Map Header and footer

with information
e e g i < when this map

was created, by

whom and using

U.S. Map with what data set.
data overlay.

Listing of map

type, author, and Map legend with

parameters used. color coding.

Area (Linsar) +—

— Geo Map (Circle Annotation 3tyle) Intariag Zelor [Linsar)

Alber: Eqml-Area Conic Projection
Apr 10, 2011 | 09:22:15 AM
E. Boroer



O 2 Workshop Overview

1:15 Marcoscope Design and Usage & CIShell Powered Tools: NWB & Sci2
1:45 Sci2 Tool Basics
» Download and run the tool.

2:00 Sci2 Sample Workflow: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

2:30 Sci2 Sample Workflow: Studying Four Major NetSci Researchers.

» Load and clean a dataset as text file; process raw data into networks.
»  Find basic statistics and run various algorithms over the network.

> Visualize as either a circular hierarchy or network

3:30 Break

4:00 Sci2 Demo I: Geospatial maps with congressional districts

4:30 Sci2 Demo II: Evolving collaboration networks

4:45 Outlook and Discussion

5:00 Adjourn
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Sci2 Demo I1I:
Evolving collaboration networks

Dalal

Taylar oy Stanebraker Dantzich Thiel Heath
Chen Ajkan Larsan Lakbow Fox
Paxson  Wisnowsky Landay Fobhins
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Legend Node Color Code Edge Color Code
0-9 - . .
Nodes ~ Authors 1019 50-%0 N— Mapping the Evolution of
Node area size ~ Number of papers published 81-95 I Co-Authorship Networks
Node color ~ Number of citations 20-239 96 -00 I : - ' SNIp !
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Sci2 Demo I1I:
Evolving collaboration networks

L.oad isi formatted file

¢ sci2-wl.5-alpha b sampledata » scientometrics B oisi v|¢1

B Mew Folder

I'\.Iarm;F Date rmodified Type Size

{0 Alessandratespignani.isi : |7 EugeneGarfield.isi

| 7| FourMetieiResearchers.isi

|7 LaszloBarabasiisi |
| 7| StanleyWWasserman.isi || TestSPapers.isi

As csv, file looks like:

A | B | C | b | E | F |UEe
1 |Abstract Authors Authars (Full Mames) Beginning Book Serie Book Serie Cited Patel
2 |The systematic study ol Colizza, V|Barrat, AlBarthelemy, M[Vespignani, A 2015
3 |Uncaovering the hidden reColizza, Y|Flammini, AlSerranao, MANVespignani, A 110
4 |Computer viruses can s|%espignani, & 135
_ 8 |Mapping the Internet gelDall'Asta, L|Avarez-Hamelin, [[Barrat, APvazguez, Alvespignani, A 140 LECTURE MNOTES IM

Visualize each time slide separately:

Wosmgnan, &

Pastrm e, |

W v g

®vpruen @ pongas R
Wi W

1990-1091 1990-1005 1480-2001
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Relevant Sci2 Manual entry

Home
1 Intreduction
2 Getting Started

3 Algorithms, Tools,
and Plugins

4 Workflow Design
= 5 Sample Workflows

= 5.1 Individual Level
Studies - Micro
5.1.1 Mapping
Collaboration,
Publication, and
Funding Profiles
of One
Researcher
(EndMote and
NSF Data)
5.1.2 Time Slicing
of Co-Authorship
Networks (ISI
Data)
5.1.3 Funding
Profiles of Three
Researchers at
Indiana University
(NSF Data)
5.1.4 Studying
Four Major NetSci
Researchers (15
Data)
5.2 Institution Level
Studies - Meso
5.3 Global Level
Studies - Macro
6 Sample Science
Studies & Online
Senices
7 Extending the Sci2
Tool
8 Relevant Datasets
and Tools
9 References

hitp:/ [ sci2.wikis.cns.in.edu/ 5. 1.2+ Time+S licing+of+ Co-Authorship+Networks+ (IS1+Data)

m

éﬁ! Tools -

5.1.2 Time Slicing of Co-Authorship Networks (I1SI Data)

&6 Added by Ted Polley, last edited by Scott Weingart on Mar 16, 2011 (view change)

AlessandroVespignani.isi
Time frame: 1990-2006

Region(s): Indiana University, University of Rome, Yale University, Leiden University, International Center for Theoretical Physics,
University of Paris-Sud

Topical Area(s): Informatics, Complex Metwork Science and System Research, Physics, Statistics, Epidemics

Analysis Type(s): Co-Authorship Metwork

The Sci® Tool supports the analysis of evolving networks . For this study, load Alessandro Vespignani's publication history from ISI, which can be
downloaded from Thomson's Web of Science or loaded using "File > Load" and following this path: 'yoursci2directory/sampledata/scientometrics

AsifAlessandroVespignani.isiusing.’ Slice the data into five year intervals from 1990-2006 using Preprocessing = Temporal > Slice Table by Time' and the
following parameters:

[E=E=RT)

Slice a table into groups of rows by time.

.
(% Slice Table by Time

Date/Time Column [Publication Year

Date/Time Format  yyyy

Slice Into [‘r’ears
How Many? 5

From Time 1990
To Time 2006

Cumulative?

[C] Align With Calendar

Week Starts On [Sundav
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Slice Table by Time

’
&% Slice Table by Time

= | B [ |

Slice a table into groups of rows by time.

Date/Time Column [F‘ubiicatiun Year

Date/Time Format vy

Cumulative?

[C] Align With Calendar

Slice Into ["r’ears
How Many? 5

From Time 1990
Te Time 2006

Week Starts On Sunday

"Slice Into” allows the user to slice the table by days, weeks, months, quarters, years, decades, and
centuties. There are two additional parameters for time slicing: curmulative and align with calendar. The
forrmer produces tables containing all data from the beginning to the end of each table's time interval, which
can be seen in the Data Manager and below,

(=R5} 101 Unique IS Records
ﬂ slice from beginning of 1990 to end of 2006 (101 records)
slice Frorm beqginning of 1990 ta end of 2001 (RS records)
slice From beginning of 1990 to end of 1996 {26 records)
slice From beginning of 1990 to end of 1991 {4 records)

The latter option aligns the output tables according to calendar intervals:

=63

101 Unigue ISI Records
ﬂ glice from beginning of 2002 to end of 2006 (36 records)
slice From beginning of 1997 to end of 2001 (39 records)
slice Frarm beginning of 1992 ko end of 1996 (22 recards)
slice from beginning of 1990 to end of 1991 (4 records)

Choosing "Years" under "Slice Into" creates multiple tables beginning from January 17 of the first year. If
"Months" is chosen, it will start from the first day of the earliest month in the chosen time interval.

hitp:/ [ sci2.wikis.cns.in.edu/ 5. 1.2+ Time+S licing+of+ Co-Authorship+Networks+ (IS1+Data)
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Visualize Each Network, Keep Node Positions

1. To see the evolution of Vespignani's co-authorship network over time, check ‘cumulative’.

2. Extract co-authorship networks one at a time for each sliced time table using 'Data
Preparation > Extract Co-Author Network', making sure to select "ISI" from the pop-up
window during the extraction.

3. To view each of the Co-Authorship Networks over time using the same graph layout,
begin by clicking on longest slice network (the 'Extracted Co-Authorship Network' under 'shice
Srom beginning of 1990 to end of 2006 (107 records)’) in the data manager. Visualize it in
GUESS using 'Visualization > Networks > GUESS".

4. From here, run 'Layout > GEM' followed by 'Layout > Bin Pack'. Run 'Script > Run Script
... and select ' yoursci2directory/ scripts/ GUESS / co-author-nw.py’.

5. In order to save the x, y coordinates of each node and to apply them to the other time
slices in GUESS, select 'File > Export Node Positions' and save the result as
oursci2directory/ NodePositions.cs'. Load the remaining three networks in GUESS using the
steps described above and for each network visualization, run 'File > Import Node Positions'
and open "yoursci2directory/ NodePositions.csv'.

0. To match the resulting networks stylistically with the original visualization, run "Seript >
Run Script ..." and select "yoursci2directory/ scripts/ GUESS [ co-author-nw.py’, followed by 'layout >
Bin Pack’, for each.

http:/ [ sci2.wiki.cns.in.edu/ 5. 1.2+ Time+S licing+of+Co-Authorship+ Networks+ (1S 1+ Data)
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= A tool for

== Visualize Each Network, Keep Node Positions

S research & practice

. Vespignani A e h Patri A

| Pletronar, L "
@ sigeesn s
[ Jr—"" =7l :
@iz s @i /) ® Dt
/’ ® R,
.. ‘ b 2 2,4 indabrol, B8
Wii?m Deangelis, R Fe @
Warsdl, M . m‘ SHETE ¥ekutied, |
‘ M, M
1990-1991 1 !
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Relevant CIShell plugin

Slice Table by Time £ Tools ~

Added by Aretha Alencar, last edited by Ted Polley on Jan 12, 2011 (view change)

Description

Slice Table By Time is an algorithm to chop a table up into new tables. based on a date/time column. It takes the column with the date/time data, a string
describing the format of that column, the intervals that the data should be sliced into, whether or not the slices are cumulative, whether or not the slices should be
aligned with the calendar, and what day the week is considered to start on (which only matters if the slices are aligned with the calendar) as parameters.

The column to use for date/time values should have a single value for each row of data. It is used by the algorithm to choose which slice(s) the row should end up
in. In order to determine what date/time is represented by that row, you must provide the algorithm with a descriptive format, in the second parameter. For instance,
a four digit year would be represented by yyyy (the default value). See http/fjoda-time sourceforge net/api-release/org/joda/time/format/DateTimeFormat html for
details of all the various formatting options.

The next dropdown has the available intervals to slice the table into. These include milliseconds, seconds, minutes, hours, days, weeks, fortnights, months,
quarters, years, decades, and centuries. A future version of the algorithm may include the ability to select how many of these intervals should be grouped together
at once.

The checkbox that follows determines if the slices will be cumulative. If the slices are not cumulative, every row in the original table is in one and only one resulting
slice. However. if the slices are cumulative, every row in the original table is in the slice it is for and every slice for a period after that.

The checkbox that follows determines if the slices will be aligned with the calendar. For instance, if the first row is for June 7th, 2006 and yearly slices are chosen,
then the default behavior will be to have the first slice be from June 7th, 2006 to June 6th, 2007. However, if the slices are aligned with the calendar, the first slice
will ke from January 1st. 2006 to December 31st, 2006. Alignment does not affect the output for intervals of fortnights. quarters, decades, or milliseconds.

If the slices are aligned with the calendar and are weekly, then the day the week starts is used to determine how they are aligned.

Pros & Cons

The output of the slice algonthm is in separate tables, so a longitudinal analysis will require working with each slice separately, which can be awkward. There will
likely be future versions of the time slice algorithm that annotate the original table with the slice the rows belong to.

Applications

When doing longitudinal analysis of data. it can be useful to consider it in chunks, such as to calculate how statistics have changed over time. Alternatively, only a
particular time period might be of interest, and this algorithm can extract it from data for a larger time range.

Implementation Details

This algorithm uses the Joda Time library extensively, which provides significantly improved capabilities compared to the default Java algorithms for dates and
times.

bttp:/ [ cishell.wiki.cns.in.edu/ S lice+ Table+by+Time
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O 2 Workshop Overview

1:15 Marcoscope Design and Usage & CIShell Powered Tools: NWB & Sci2
1:45 Sci2 Tool Basics
» Download and run the tool.

2:00 Sci2 Sample Workflow: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

2:30 Sci2 Sample Workflow: Studying Four Major NetSci Researchers.

» Load and clean a dataset as text file; process raw data into networks.
»  Find basic statistics and run various algorithms over the network.

> Visualize as either a circular hierarchy or network

3:30 Break

4:00 Sci2 Demo I: Geospatial maps with congressional districts

4:30 Sci2 Demo 1I: Evolving collaboration networks

4:45 Marcoscopes: Outlook and Discussion

5:00 Adjourn
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Spﬁ SCHOLARLY DATABASE

Scholarly Database at Indiana University
bhttp:/ [ sdb.wiki.cns.in.edu

Supports federated search of 25 million publication, patent, grant records.

Results can be downloaded as data dump and (evolving) co-author, paper-citation networks.

g2 SCHOLARLY DATABASE

Cyberinfrastructure for Network Science Center, SLIS, Indiana University, Bloomington

IU User

U Users must login using the Central
Authentication Service (GAS), the standard
1 suthentication systern, Please dick the
button below to proceed to the 1U login
page.

Not Registered Yet?

Non-IU User

Ernail

Pazsword

SCHOLARLY DATABASE

Waﬁ Eq Cyberinfrastructure for Network Science Center, SLIS, Indiana University, Bloomington

Register as an IU User
Register as a Non 1U User

In the News

whitfield, John. 2008. Group Theory. Naturs, 455, 9 720-723.

Please Cite As

Madrid, Spain, June 25-27, 2007, pp. 457-462,
htip:/ fella.slis.indiana.edu/ ~katy /paper/ 07 -issi-sdb.pdf

Ack led

La Rawe, Gavin, Ambre, Sumeet, Burgoan, John, Ke, Weimao and Bérmer, Katy, (2007) The Scholarly Database and Its
Utility for Seientomnetrics Resesrch, In Procesdings of the 11th Inkernational Conference on Sdentornstrics and Informetrics,

INDTANA UNIVERSITY
@) SCHOOL OF LIBRARY
AND INFORMATION SCIENCE

The Scholarly Database is funded by the Schaal of Library and Infarmation Sdence and the Cyberinfrastructure for Netuork
Srience center st Indiana University, the National Sdence Foundation under Grants No. [13-0238261 and 115-0913650, and
aJames 8. McDonnell Foundation grant in area Studying Complex Systams.

Any opinions, findings, and condlusions or recommendations expressed in this material are those of the authar(s) and do
not necessarily reflect the views of the National Science Foundation,

James S. McDonnell Foundation

Edit Profile | Admin | About

Logout

If multiple terrns are entered in a field, they are
Search automatically combined uzing *OR’. So, "breast
cancer’ rmatches any record with *breast’ or ‘cancer’ in

Creators: I that field.
. “ou can put AMD between terms to combine with
Title: I “AMDY Thus ‘breast AND cancer’ would only rmatch
records that contain both terms,
Abstract: IRNAi
Double quetation can be used to match compound
Full Text: I terms, &g, ““breast cancer™ retrisves records with
the phrase “breast cancer”, and not records where
First Year: I 1898 vl ‘breast’ and "cancer’ are both present, but not the

exact phrasze,
Last Year: IZDUB 'l

¥ Mediine (1898 - 2008)
¥ nin (1961 - 2002)
¥ NsF (1985 - 2004)

The irmpartance of 2 particular tarrn in 2 query can be
increased by putting a ™~ and a number after the
term, For instance, *breaszt cancer™10” would increaze
the importance of matching the term ‘cancer’ by ten
compared to matching the term *breast’,

I uspro (1976 - 2007)

Register for free access at http://sdb.cns.iu.edu
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Eile Edit ‘Wjew History  Bookmarks

Tools
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¥ scholarly Database :: Download - Mozilla Firefox o ] [
File Edit Miew History Bookmarks Tools  Help
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Cybennfrastructure for Network Science Center, SLIS, Indiana University, Bloomington

. Search Edit Profile Admin About Logout

Download Results
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Co-author
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e CIS

CIShell — Integrate New Algorithms

About the Cyberinfrastructure Shell Learn More...

The Cyberinfrastructure Shell (ClShell) is an open source, community-driven platform for the » ClShell Fapers
integration and utilization of datasets, algorithms, tools, and computing resources. Algarithm ) ClSh'_E” Fowered Tools
integration suppart is built in for Java and most other programming languages. Being Java based, ' ﬂgm _

it will run on almost all platforms. The software and specification is released under an Apache 2.0 * Plugins (coming soon]
License. » Migc. Tool Documentation

= ClShell Web Serices (coming soon)

ClShell is the basis of Metwork Woarkbench, TexTrend, Sci® and the upcoming EpiC tool. » Screenshats

ClIShell supports remote execution of algorithms. A standard web service definition is in
development that will allow pools of algarithms to transparently be used in a peer-to-peer, client- Gettlng Started

server, or wehb front-end fashion.

ClIShell Features

» Docurmentation & Developer Resources

= Download

Getting Involved...

A framework for easy integration of new and existing algorithms written

in any programming language

= Contact Ls

Using ClShell, an algarithm writer can fully concentrate on creating their own algarithm in whatever
language they are comfortable with. Simple tools are provided to then take their algorithm and

CIShell Developer Guide is at )1tp:/ / cishell.wiki.cns.in.edu

Additional Sci2 Plugins are at hlip:/ [ sci2.wiki.cns.in.edu/ 3.2+ Additional+ Plugins
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597 C I CIShell — Add new Plugins, e.g., Cytoscape

Adding more alyout algorithms and network visualization interactivity

via Cytoscape http://www.cvtoscape.org.

Cytoscape |

Simply add org. textrend.visualization.cytoscape_0.0.3.jar into your /plugin directory.

Restart Sci2 Tool.

Cytoscape now shows in the Visualization Menu.

File [ata Preparation Preprocessing  Analysis  Modeling RUENEEERRGS Help
[

ECDnsnle Szl = 08 || ¥ pata Manager
Temporal

Cytoscape was selected, Geospatial  #
Integratoris): TexTrend Consortiorn (http:/ Swww textrend  pebworks ¢ [pis (TexTrend, =- E‘ 361 IJnique 151 Records
Universitas Press)

Reference: Cvtoscape Consortium (http:/ Swww. cytoscap

E' Authar informnation

CADOCUME- 1 bornerki L AL~ 14 TemphCIShell-Session-688324 7 785800266 7994 StaticExecutable
Runner-206871827 1483870377 algarithm =echa off

cykoscape, CytoscapeInit[INFO]: Cytoscapelnit skatic initialization

cytoscape. CytoscapeInit[INFO]: Parent_Dir: C:\Documents and Settings)bornerk),. cvkoscape
created,

” = E' 151 Data: ChDocuments and Settingsiborner

Cytoscape 1", Extracted Co-Autharship Metwork

Select a network in Data Manager, run Cytoscape and the tool will start with this

network loaded.
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Mode Aktribube Browser | Edoe Attribuke Browser | Metwark Akkribube Browser
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‘%aC | 0SGi/CIShell Adoption

A number of other projects recently adopted OSGi and/or CIShell:

Cytoscape (bttp:/ [ cytoscape.ors) Led by Trey Ideker at the University of California, San Diegois an
open source bioinformatics software platform for visualizing molecular interaction networks
and integrating these interactions with gene expression profiles and other state data (Shannon

et al., 2002).

> Taverna Workbench (biip:/ [ taverna.org.nk) Developed by the myGrid team
(http://myerid.ore.uk) led by Carol Goble at the University of Manchester, UK. is a free
software tool for designing and executing workflows (Hull et al., 2006). Taverna allows users
to integrate many different software tools, including over 30,000 web services.

> MAEviz (bips:/ [ wiki.nesa.ninc.edu/ display/ MALE/ Flone) Managed by Jong Lee at NCSA is an
open-source, extensible software platform which supports seismic risk assessment based on
the Mid-America Earthquake (MAE) Center research.

» TEXTrend (bttp:/ / textrend.ors) Led by George Kampis at E6tvos Lorand University, Budapest,
Hungary supports natural language processing (NLP), classification/mining, and graph
algorithms for the analysis of business and governmental text corpuses with an inherently
temporal component.

»  DynalNets (bitp:/ [ www.dynanets.ors) Coordinated by Peter M.A. Sloot at the University of
Amsterdam, The Netherlands develops algorithms to study evolving networks.

As the functionality of OSGi-based software frameworks improves and the number and

diversity of dataset and algorithm plugins increases, the capabilities of custom tools will expand.
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TEXTREND
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Publications Downloads Archives Tutorials Support Media

TEXTREND: Development of a business and governmental decision support
toolbox using trend- and text-analysis tools

The two interconnected objectives of the TEXTrend project are (1) the creation of

an integrated TEXTrend toolkit and service basis, and (2) the elaboration of
demonstrative applications in varied fields of business and governmental
decisions, exemplified by use cases,
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TEXTrend adds R bridge, WEKA, Wordij, CFinder, and more.

See the latest versions of TEXTrend Toolkit modules at

http:/ [ texctrend.org/ index.phpZoption=com _content>view=articlec>id=47 & Itemid=53
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&4 EpiC Tool

File | Compartmental Modeling | Metworks Simulation  Visualization R Help

El Console

= O || i Data Manager

Create a compartmental model

Edit compartmental model

Metwork Science Center (http:/fons.slis.indi

EpiC uses the Cyberinfrastructure Shell (http://cishell.org) developed at the Cyberinfrastructure for

visualization of epidemic processes.  »

he MIH RM-07-004 award, The
d Dr. Jim Sherman.

Chintan Tank, Joseph Biberstine,

Please cite as follows:

Simulation | Visualization R Help

EpiC Team. (2003). EpiC Tool. Indiana Unive single-Population
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I Visualization | R Help
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School of Library and Information Science | Indiana University Bloomington

Cyberinfrastructures Teaching Outreach

All papers, maps, tools, talks, press are linked from http://cns.iu.edu

CNS Facebook: http://www.facebook.com/pages/Cyberinfrastructure-for-
Network-Science-Center/144339535612571

Maping Science Exhibit Facebook: http://www.facebook.com/mappingscience
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